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஢ா஝ண் - 1 

அட஝ா஢் ட஢஛்டணக்க஥ ்

஢குதி – அ 

I ச஥ிதா஡ விட஝டதட ்டடா஠்்தடடுடத்ு ஋ழுதுக. 

1 DTP எ஦்஧த஦் விபியாக்கந் அ) Desktop Publishing  

2 _________ எ஦்஧து ஒரு DTP  மந஦்ம஧ாரு஭ாகுந்.  ஆ) PageMaker  

3 எ஥்த ஧ட்டியி஬் New கட்டள஭ இடந் ம஧஫்று஭்஭து?  அ) File menu  

4 
Page Maker ச஦்஦஬் திளபயி஬் கரு஧்பு ஥ி஫ எ஬்ள஬க்ககாட்டி஫்கு மய஭ியி஬் 

இருக்குந் ஧குதி __________ எ஦ அளமக்க஧்஧டுந்  ஆ) pasteboard 
 

5 
PageMaker ஆயணத்ளத மூடுயத஫்கா஦ விளச஧்஧஬ளக குறுக்கு யழி_________ 
ஈ) Ctrl+W 

 

6 
_________ கருவி ஆயணத்தி஦் ஒரு ஧குதிளன஧் ம஧பிதாக்கி஧் ஧ாபக்்க஧் 

஧ன஦்஧டுகி஫து.     இ) Zoom tool 
 

7 த஢஝்டிகந் பட஥பட஦்கு஢் ஢த஡்஢டுண் கருவி _________ இ) Rectangle  

8 Place க஝்஝டந _________஢஝்டிம௃஧் இ஝ண் த஢஦்றிருக்குண் அ) File   

9 
முழு ஆபஞட்டடட் டட஥஠்்தடடுக்க விநச஢்஢஧டகம௃஧் ____குறுக்கு பழி சாவி 

டசாண்ா஡ட்டட அழுட்ட டபஞ்டுண். அ) Ctrl+A 
 

10 
஋ழுட்து படிவூ஝்஝஧் கீன்க்கஞ்஝ப஦்றி஧் ஋஠்ட ஢ஞ்புகடந஢் த஢஦்றிருக்குண்?  

ஈ) All of these 

 

11 உட஥டத ஢தி஢்பிக்க ஢த஡்஢டுண் கருவி ஋து? அ) Text tool  

12 
PageMaker இ஧் ஆபஞட்டட அசச்ி஝஢் ஢த஡்஢டுண் விடச஢்஢஧டக குறுக்கு பழி 

_________ ஆ) Ctrl +P 
 

13 அட஝ா஢் ட஢஛்டணக்க஥ ்஋஡்஢து ஢க்க படிபடண஢்பு தண஡்த஢ாருநாகுண்.  

14 
டட஧஢்பு஢் (Title bar) ஢஝ட்஝ ட஢஛்டணக்க஥ ்ஆபஞட்தி஡் டண஧்஢குதிம௃஧் 

இருக்குண். 
 

15 
ஆபஞட்டட டணலுண் கீழுணாகவுண், இ஝து ண஦்றுண் ப஧து பு஦ணாகவுண் 

஠க஥ட்்துபடட திட஥ உருந஧் ஢஝ட்஝ (Scrolling bar)   ஋஡்கிட஦ாண்.   
 

16 Ellipse Tool கருவி ப஝்஝ண் பட஥பட஦்கு஢் ஢த஡்஢டுகி஦து.  

17 Layout ஢஝்டிடதக் கிநிக் தசத்து Insert Pages விரு஢்஢ட்டட஢் த஢஦஧ாண்.  

18 

த஢ாருட்துக. 

அ) Cut  (iii)  Ctrl+X 

ஆ) Copy (iv) Ctrl+C  

இ) Paste (ii)  Ctrl+V  

ஈ) Undo  (i)  Ctrl+Z 

 

19 
கீன்க்கஞ்஝ப஦்றி஧் த஢ாரு஠்டாட எ஡்ட஦ட் டடா஠்்தடடு.  

i. Adobe PageMaker, QuarkXPress, Adoble InDesign, Audacity 

 

20 

கீன்க்கஞ்஝ப஦்றி஧் ச஥ிதா஡ கூ஦்ட஦ட் டட஥஠்்தடடு.  

i. ஆ) சு஝்டி ண஦்றுண் விடச஢்஢஧டகம௃஡் மூ஧ண் உட஥டதட் டட஥஠்்தடடுக்க 

முடிம௅ண்.  

ii. அ) DTP ஋஡்஢ட஡் வி஥ிபாக்கண் Desktop publishing. 

 

21 

கீன்க்கஞ்஝ப஦்றி஧் ச஥ிதா஡ இடஞடதட் டட஥஠்்தடடு.  

i. அ) Edit Cut  

ii. ஆ) Undo Redo   
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஢குதி ஆ 

II மூ஡்று ப஥ிகநி஧் விட஝தநிக்கவுண். 

1 

Desktop Publishing ஋஡்஦ா஧் ஋஡்஡?  

DTP ஋஡்஢ட஡் வி஥ிபாக்கண் Desktop publishing. DTP தண஡்த஢ாருடந 

஢த஡்஢டுட்தி ஆபஞங்களுக்கா஡ ஢க்கங்கடந படிபடண஢்பு தசத்படாகுண். 

 

2 

DTP தண஡்த஢ாருந்களுக்கு ஋டுடத்ுக்கா஝ட்ுகந் டருக?  

DTP தண஡்த஢ாருந்கந் சி஧ அட஝ா஢் ட஢஛்டணக்க஥ ்(Adobe Pagemaker), அட஝ா஢் 

இ஡்டிடச஡் (Adobe in Design), குபா஥க்் ஋க்ஸ்பி஥ஸ் (Quark Xpress) 

 

3 

ட஢஛்டணக்க஥ ்தண஡்த஢ாருடந தி஦஢்஢ட஦்கா஡ பழிமுட஦கடநக் கூறு?  

Start → All Programs → Adobe → PageMaker7.0 → Adobe PageMaker 7.0 ஋஡்஢டட கிநிக் 

தசத்து தி஦க்க முடிம௅ண். 

 

4 

ட஢஛்டணக்க஥ ்தண஡்த஢ாருநி஧் எரு புதித ஆபஞடந்ட ஋ப்பாறு தி஦க்க஧ாண்?  

1. File-New (அ஧்஧து) Ctrl+N ஋஡்஢டட கிநிக் தசத்.  

2. உட஥தா஝஧் த஢஝்டி டடா஡்றுண். அநவுகடந உந்நடீு தசத்.  

3. OK த஢ாட்டாட஡ கிநிக் தசத். 

 

5 

எ஝ட்ு஢஧டக ஋஡்஦ா஧் ஋஡்஡?  

கரு஢்பு ஠ி஦ ஋஧்ட஧க் டகா஝்டி஦்கு தபநிம௃஧் உந்ந ஢குதி எ஝ட்ு஢்஢஧டக 

஋஡஢்஢டுண். எ஝ட்ு஢஧டகம௃஧் டபக்க஢்஢டுண் ஋துவுண் அசச்ிடுண்ட஢ாது ப஥ாது. 

படிபடண஢்பு கருவிகடந டபக்க எ஝ட்ு஢஧டகடத ஢த஡்஢டுட்ட஧ாண். 

 

6 

ட஢஛்டணக்க஥ி஧் உந்ந ஢஝ட்ி஢்஢஝ட்஝ ஢஦்றி குறி஢்பு ஋ழுதுக?  

File, Edit, Layout, Type, Element, Utilities, View, Window, Help ட஢ா஡்஦ ஢஝்டிகடந 

தகாஞ்டுந்நது. ஢஝்டிடத கிநிக் தசத்டா஧் துடஞ஢்஢஝்டித஧் டடா஡்றுண். 

 

7 

஋லி஢்ஸ் டூ஧் ண஦்றுண் ஋லி஢்ஸ் ஃபிட஥ண் டூ஧் டபறு஢டுடத்ுக. 
 

஋லி஢்ஸ் டூ஧் ஋லி஢்ஸ் ஃபிட஥ண் டூ஧் 

ப஝்஝ண், ஠ீந் ப஝்஝ண் 

பட஥த஢் ஢த஡்஢டுகி஦து.  

உட஥ ண஦்றுண் பட஥கட஧ 

டப஢்஢ட஦்கா஡ ஠ீந்ப஝்஝ங்கடந பட஥த 

஢த஡்஢டுகி஦து.  
 

 

8 

உட஥ ஢தி஢்பிடட்஧் ஋஡்஦ா஧் ஋஡்஡? 

ஆபஞட்தி஧் உட஥டத டச஥ட்்ட஧், ஠ீக்குட஧், பிடன திருட்துட஧், ஠க஥ட்்துட஧் 

ண஦்றுண் ஠க஧் ஋டுட்ட஧் ட஢ா஡்஦ தசத஧்஢ாடுகடந தசத்ட஧் உட஥ ஢தி஢்பிட்ட஧் 

஋஡்று த஢த஥.் உட஥ம௃஧் ணா஦்஦ங்கந் தசத்ட஧் உட஥ ஢தி஢்பிட்ட஧் ஋஡்று த஢த஥.் 

 

9 

உட஥ தடாகுதி ஋஡்஦ா஧் ஋஡்஡?  

உட஥ட் தடாகுதி ஋஡்஢து ஠ாண் ட஝்஝சச்ு தசத்ட உட஥டத அ஧்஧து எ஝்டித 

உட஥டத அ஧்஧து டபறு ஆபஞட்தி஧் இரு஠்து தகாஞ்டு டப஢்஢஝்஝ உட஥டத 

தகாஞ்டிருக்குண். 

 

10 

தடா஝஥ப்ுந்ந உட஥ட ்தடாகுதி ஋஡்஦ா஧் ஋஡்஡?  

எரு உட஥ட் தடாகுதிம௃஧் உந்ந உட஥டத ண஦்த஦ாரு உட஥ட் தடாகுதிக்குந் 

தச஧்லுணாறு அடணக்க முடிம௅ண். எரு உட஥ட் தடாகுதிடத ண஦்த஦ாரு 

உட஥டத்டாகுதிம௅஝஡் இநஞக்கடபா அ஧்஧து தடா஝஥ப்ு ஢டுட்டடபா தசத்த 

முடிம௅ண். இப்பாறு தடா஝஥ப்ு ஢டுட்ட஢்஢஝்டிருக்குண் உட஥டத்டாகுதிகளுக்கு 

தடா஝஥ப்ுந்ந உட஥டத்டாகுதி ஋஡்று த஢த஥.் 

 

11 

தடா஝஥ப்ுந்ந உட஥ ஋஡்஦ா஧் ஋஡்஡?  

உட஥ட் தடாகுதிகளுக்கு இட஝டத உந்ந உட஥டத இடஞக்குண் 

தசத஧்஢ா஝்டி஦்கு தடா஝஥ப்ுந்ந உட஥ ஋஡்று த஢த஥.் 

 

12 

ட஢஛்டணக்க஥ி஧் புதித ஢க்கங்கடந ஋ப்பாறு தசருக஧ாண்?  

1. Layout-Insert Pages ஋஡்஢டட கிநிக் தசத்  

2. உட஥தா஝஧் த஢஝்டி டடா஡்றுண்  

3. Insert உட஥஢்த஢஝்டிம௃஧் டச஥க்்க டபஞ்டித ஢க்க ஋ஞ்ஞிக்டகடத ட஥வுண்  

4. After (அ) Before ஋஡்஢டட டடாவ்ு தசத்  

5. Insert த஢ாட்டாட஡ கிநிக் தசத். 
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஢குதி இ 

III எரு ஢டத்ிதநவி஧் விட஝தநிக்கவுண்.  

1 

ட஢஛்டணக்க஥ ்஋஡்஦ா஧் ஋஡்஡? அட஡் ஢த஡்கடந கூறுக?  

ட஢஛்டணக்க஥ ்஋஡்஢து எரு ஢க்க படிபடண஢்பு தண஡்த஢ாருந் ஆகுண்.  

஢த஡்கந்:  

 ஢க்கங்கடந படிபடணக்க ஢த஡்஢டுகி஦து.  

 சிறித அ஝ட்஝ முட஧் த஢஥ித புட்டகண் பட஥ படிபடணக்கநாண்.  

஋நிடாக உட஥, பட஥கட஧ படிபங்கடந டச஥க்்க஧ாண். 

 

2 

ட஢஛்டணக்க஥ி஧் உந்ந ஌டடனுண் மூ஡்று கருவிகடநம௅ண் அட஡் விடச஢்஢஧டக 

குறுக்கு பழிகடநம௅ண் கூறுக? 

கருவிகந் குறுக்கு பழி 

த஥ா஝்ட஝஝்டிங் டூ஧் (Rotataing Tool)  Shift + F2  

ட஧஡் டூ஧் (Line Tool)  Shift + F3  

த஥க்஝ாங்கி஧் டூ஧் (Rectangle Tool)  Shift + F4  

஋லி஢்ஸ் டூ஧் (Ellipse Tool)  Shift + F5  

஢ாலிகா஡் டூ஧் (Polygon Tool)  Shift + F6   

 

3 

ட஢஛்டணக்க஥ி஧் உந்ந ஌டடனுண் மூ஡்று கருவிகநி஡் குறுண்஢஝ங்கடநம௅ண் அட஡் 

஢த஡்கடநம௅ண் கூறுக?  

 

கருவி ஢த஡்கந் குறுண்஢஝ண் 

ட஧஡் டூ஧் ட஠஥ ்டகாடு பட஥த  

க஡்ஸ்த஥த்஡்டு 

ட஧஡் டூ஧் 

கிட஝ண஝்஝, தசங்குட்து டகாடு 

பட஥த  

த஥க்஝ாங்கி஧் டூ஧் சது஥ண், தசப்பகண் பட஥த  

஋லி஢்ஸ் டூ஧் ப஝்஝ண், ஠ீந்ப஝்஝ண் பட஥த  

஢ாலிகா஡் டூ஧் ஢஧டகாஞண் பட஥த 
 

஛ுண் டூ஧் 
஢க்க அநடப த஢஥ிடாக, 

சிறிடாக ணா஦்஦  

த஝க்ஸ்஝் டூ஧் உட஥ உந்நி஝   

 

4 

பி஥ிக்க஢்஢஝஝் உட஥டத்டாகுதிடத ஋ப்பாறு டச஥஢்்஢ாத்?  

 தசருகுண் புந்நிடத இ஥ஞ்஝ாபது உட஥டத்டாகுதிம௃஡் கீன்஢க்க 

டக஢்பிடிம௃஧் கிநிக் தசத்து டண஧்஢குதி பட஥ இழுக்கவுண்  

 தசருகுண் புந்நிடத முட஧் உட஥டத்டாகுதிம௃஡் கீன்஢க்க டக஢்பிடிம௃஧் 

கிநிக் தசத்து டண஧்஢குதி பட஥ இழுக்கவுண். 

 

5 

உட஥ உந்ந ச஝஝்ங்கடந ஋ப்பாறு இடஞ஢்஢ாத்?  

• இ஥ஞ்஝ாபது ச஝்஝ண் பட஥த டபஞ்டுண்  

• முட஧் ச஝்஝ட்டட கிநிக் தசத்  

• கீன்஢க்க டக஢்பிடிம௃஧் உந்ந சிப஢்பு முக்ககாஞட்டட கிநிக் தசத்  

• இ஥ஞ்஝ாபது ச஝்஝ட்டட கிநிக் தசத் 

 

6 

ணாஸ்஝஥ ்஢க்கடத்ி஡் ஢த஡் ஋஡்஡?  

ணாஸ்஝஥ ் ஢க்கட்தி஧் டபக்க஢்஢டுண் ஋஠்ட எரு த஢ாருளுண் ஆபஞட்தி஧் உந்ந 

஋஧்஧ா ஢க்கங்கநிலுண் டடா஡்றுண். எப்தபாரு ஢க்கங்கநிலுண் த஢ாருடந 

டசாக்்க டடடபம௃஧்ட஧.  

ணாஸ்஝஥ ்஢க்கண் டட஧஢்பு, அடிக்குறி஢்பு, ஢க்க ஋ஞ்கந், ட஧ாடகாக்கந் 

ஆகிதப஦்ட஦ தகாஞ்டுந்நது.  

 

7 

ணாஸ்஝஥ ்஢க்கடத்ி஧் ஢க்க ஋ஞ்கடந ஋ப்பாறு டசா஢்்஢ாத்?  

1. Master Pages ஢ஞிக்குறிடத கிநிக் தசத்  

2. T ஢ஞிக்குறிடத கிநிக் தசத்  

3. இ஝து ணாஸ்஝஥ ்஢க்கட்டட கிநிக் தசத்  
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4. Ctrl + Alt + P ஋஡்஢டட கிநிக் தசத்  

5. ஢க்க ஋ஞ் LM ஋஡ டடா஡்றுண்  

6. ப஧து ணாஸ்஝஥ ்஢க்கட்டட கிநிக் தசத்  

7. Ctrl + Alt + P ஋஡்஢டட கிநிக் தசத்  

8. ஢க்க ஋ஞ் RM ஋஡ டடா஡்றுண் 

 

஢குதி ஈ 

IV எரு ஢க்க அநவி஧் விட஝தநிக்கவுண். 

1 

ட஢஛்டணக்கா ்கருவி஢்஢஝ட்ிம௃லுந்ந கருவிகடந஢் ஢஦்றி விப஥ி. 

 

஢ாம௃஡்஝ா ்டூ஧் 
உட஥ ண஦்றுண் பட஥கட஧஢் ஢஝ங்கடநட் 

டடா஠்்தடடுக்க, ஠காட்்ட, அநடப ணா஦்஦ 

த஝க்ஸ்஝் டூ஧் 
உட஥டத உந்நி஝, டடா஠்்தடடுக்க, 

஢தி஢்பிக்க 

த஥ா஝்ட஝டிங் டூ஧் 
த஢ாருந்கடந டடா஠்்தடடுக்க ண஦்றுண் 

சுன஦்஦ 

கி஥ா஢்பிங் டூ஧் பட஥கட஧கடந எழுங்கடணக்க 

ட஧஡் டூ஧் ட஠ாட்காடு பட஥த 

க஡்ஸ்த஥த்஡்டு ட஧஡் 

டூ஧் 

கிட஝ண஝்஝ணாகவுண், தசங்குட்டாகவுண் 

டகாடுகந் பட஥த 

த஥க்஝ாங்க஧் டூ஧் சது஥ண் ண஦்றுண் தசப்பகண் பட஥த 

த஥க்஝ாங்க஧் ஃபிட஥ண் டூ஧் 
உட஥ ண஦்றுண் பட஥கட஧கடந 

டப஢்஢ட஦்கா஡ தசப்பகங்கடந பட஥த 

஋லி஢்ஸ் டூ஧் ப஝்஝ண் ண஦்றுண் ஠ீந்ப஝்஝ண் பட஥த 

஋லி஢்ஸ் ஃபிட஥ண் டூ஧் 
உட஥ ண஦்றுண் பட஥கட஧கடந 

டப஢்஢ட஦்கா஡ ஠ீந்ப஝்஝ங்கடந பட஥த 

஢ாலிகா஡் டூ஧் ஢஧டகாஞங்கந் பட஥த 

஢ாலிகா஡் ஃபிட஥ண் டூ஧் 
உட஥ ண஦்றுண் பட஥கட஧கடந 

டப஢்஢ட஦்கா஡ ஢஧டகாஞங்கந் பட஥த 

டஹஞ்஝் டூ஧் ஢க்கட்டட திட஥ உருந஧் தசத்த 

஛ூண் டூ஧் 
஢க்கட்தி஡் அநடப த஢஥ிடாக்கிம௅ண் 

சிறிடாக்கிம௅ண் ஢ா஥க்்க  

 

2 

ச஝்஝டத்ி஧் உட஥டத டப஢்஢ட஦்கா஡ பழிமுட஦கடநக் கூறு. 

 கருவி஢்த஢஝்டிம௃஧் உந்ந ஌டடனுண் எரு பிட஥ண் டூட஧ டடாவ்ு 

தசத்தடபஞ்டுண். 

 அடட஢் ஢த஡்஢டுட்தி எரு ச஝்஝ண் பட஥த டபஞ்டுண். 

 அசச்஝்஝ட்டட டடாவ்ு தசத்த டபஞ்டுண். 

 File -> Place ஋஡்஢டட டடாவ்ு தசத்த டபஞ்டுண். Place உட஥தா஝஧் த஢஝்டி 

டடா஡்றுண். 

 அதி஧் தசருக டபஞ்டித உட஥டத டடாவ்ு தசத்த டபஞ்டுண். 

 Open த஢ாட்டாட஡ கிநிக் தசத்த டபஞ்டுண். 

 உட஥தா஡து ச஝்஝ட்தி஧் தசருக஢்஢஝ட்ுவிடுண். 

 

3 

உட஥ட ்தடாகுதிம௃லுந்ந உட஥டத ச஝்஝டத்ி஦்கு ஋ப்பாறு ணா஦்றுபாத்? 

 கருவி஢்த஢஝்டிம௃஧் உந்ந ஃபிட஥ண் டூ஧்கநி஧் ஌டடனுண் எ஡்ட஦ 

஢த஡்஢டுட்தி ச஝்஝ண் எ஡்ட஦ பட஥தவுண்.  

 தசருக டபஞ்டித உட஥டத்டாகுதிடத டடா஠்்தடடுக்க டபஞ்டுண்.  

 Shift த஢ாட்டாட஡ அழுட்திக் தகாஞ்டு ச஝்஝ட்டட கிநிக் தசத்த 

டபஞ்டுண். 

 Element -> Frame -> Attach Content ஋஡்஢டட கிநிக் தசத்த டபஞ்டுண். 

 உட஥தா஡து ச஝்஝ட்தி஦்கு உந்டந டடா஡்றுண். 
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4 

஢ாலிகா஡் டூட஧஢் ஢த஡்஢டுடத்ி எரு ஠஝ச்டத்ி஥ண் பட஥பட஦்கா஡ 

பழிமுட஦கடநக் கூறு. 

 கருவி஢் த஢஝்டிம௃஧் ஢ாலிகா஡் டூட஧ டடாவ்ு தசத்த டபஞ்டுண்.  

 திட஥ம௃஧் சு஝்டிடத அழுட்திக் தகாஞ்டு ஢ாலிகா஡் பட஥த டபஞ்டுண்.  

 Element -> Polygon Settings ஋஡்஢டடட் டடாவ்ு தசத்த டபஞ்டுண்.  

 Polygon Settings உட஥தா஝஧் த஢஝்டி டடா஡்றுண்  

 Number of Side உட஥஢்த஢஝்டிம௃஧் 5 ஋஡ உந்நி஝ டபஞ்டுண். 

 Star inset உட஥஢்த஢஝்டிம௃஧் 50% ஋஡ ட஝்஝சச்ு தசத்த டபஞ்டுண்.  

 OK த஢ாட்டாட஡ அழுட்டவுண்  

 திட஥ம௃஧் ஠஝ச்ட்தி஥ண் டடா஡்றுண். 
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஢ா஝ண் - 2 

அட஝ா஢் இ஡்டிடச஡் CC 2019 

஢குதி - அ 

I ச஥ிதா஡ விட஝டதட ்டடா஠்்தடடுடத்ு ஋ழுதுக. 

1 
எ஡்று அ஧்஧து அட஦்கு டண஦்஢஝்஝ ச஝்஝ங்கடந ஆக்கி஥மிட்திருக்குண் 

தடா஝஥ச்ச்ிதா஡ உட஥ அ) கடட (story) 
 

2 
In Design-னுந்ந எப்தபாரு உட஥ம௃஡் துஞ்டு஢் ஢குதிம௅ண் அ) உட஥ச ்ச஝்஝ண் (text 

frame) 
 

3 ஆபஞட்டடச ்சு஦்றிம௅ந்ந ஢குதி அ) எ஝ட்ு஢்஢஧டக (pasteboard)  

4 
எ஡்ட஦ எ஡்று ஢ா஥க்்குண் படகம௃஧் அடண஠்துந்ந இ஥ஞ்டு ஆபஞ஢் 

஢க்கங்கநி஡் தடாகுதி அ) ஢஥ப஧் (spread) 
 

5 
………………… ஋஡்஢து Indesign-஧் உந்ந அட஡ட்து கருவிகடநம௅ண் தகாஞ்டுந்ந 

த஢஝்டிதாகுண். அ) கருவி஢் ஢஧கண் (Tools panel) 
 

6 ஢க்கட்தி஡் இ஥ஞ்டு த஠டுப஥ிடசகளுக்கு இட஝஢்஢஝்஝ ஢குதி அ) Gutter  

7 
எரு ஢க்கட்தி஧் இ஝ண்த஢ருண் உட஥஢்஢குதி அ஧்஧து உறு஢்பு அ) பட஥கட஧ 

(Graphics) 
 

8 
…….. ஋஡்று Adobe Photoshop ட஢ா஡்஦ ஠ி஥஧் மூ஧ண் உருபாக்க஢்஢டுண் 

஢஝஢்புந்நிகடநக்(pixels) தகாஞ்஝ ஠ின஦்஢஝ங்கந் அ) பி஝ட்஝஢் (bitmaps) 
 

9 
இ஥ஞ்டு அ஧்஧து மூ஡்று பஞ்ஞங்கந் ஢டி஢்஢டிதாக இடஞட்து க஧டப அ) 

Gradient 
 

10 ஠ிறுப஡ங்கநா஧் டதா஥ிக்க஢்஢டுண் தசத஧஦்஦ அ) Spot ஠ி஦ங்கந் (Spot Colours)  

11 எரு த஢ாருநி஡் உந்டந இ஝஢்஢டுண் பஞ்ஞண் அ) ஠ி஥஢்பு (Fill)  

12 த஢ாருநி஡் தபநி஢்பு஦க் டகா஝்டி஧் இ஝஢்஢டுண் பஞ்ஞண் அ) ஋஧்ட஧ (stoke)  

13 

View க஝்஝டநகடந அட஡் ஢த஡்஢ா஝ட்ு஝஡் த஢ாருட்துக 
 

Zoom in  
ஆ) அடுடட் மு஡்படிபடணக்க஢்஢஝஝் சடவிடடத்ி஦்கு 

உரு஢்த஢ருக்கண் தசத்த  

Zoom out  
ஈ) மு஠்டடத மு஡் படிபடணக்க஢்஢஝஝் சடவிடடட்ட 

குட஦டட்஧் ண஦்றுண் திருண்஢஢்த஢஦஧்  

Actual size  அ) ஆபஞடட்ட 100% சடவீடண் காஞ்பிக்க  

Fit page in window  
உ) கா஝ச்ி திட஥ம௃஡் அநடப, திட஥ம௃஡் அநவி஦்கு 

த஢ாருடத்ுபட஦்காக அநவிடுட஧்  

Fit spread in window  இ) ச஡்஡஧் திட஥ம௃஧் இ஧க்கு ஢஥பட஧ காஞ்பிக்க  
 

 

 

஢குதி - ஆ 

II மூ஡்று ப஥ிகநி஧் விட஝தநிக்கவுண். 

1 

Adobe in Design ஋஡்஡ தண஡்த஢ாருந்?  

Adobe InDesign CC 2019 ஋஡்஢து ‘Adobe Creative Clud’ குடுண்஢ட்தி஡் தண஡்த஢ாருந் 

஠ி஥லி஡் எரு ஢குதிதாகுண். InDesign ஋஡்஢து ஢க்க படிபஅடணவு தண஡்த஢ாருந் 

஠ி஥஧ாகுண். இது படிபடண஢்பி஦்குண் ண஦்றுண் பட஧ம௃஧் அசச்ிடுபட஦்கு அ஧்஧து 

஢த஡்஢டுட்துபட஦்கா஡ ஆபஞங்கடந உருபாக்குபட஦்குண் ஢த஡்஢டுகி஦து. 

஋நித பஞிக அ஝ட்஝ முட஧் த஢஥ித புட்டகண் பட஥ ஋டட டபஞ்டுணா஡ாலுண் 

உருபாக்க஧ாண். 

 

2 
஋டட்ட஡ படகதா஡ தகா஝஠ிட஧ ஢க்க அடணவுகந் உந்ந஡? அடப ஋டப?  

Orientation : ஆபஞட்தி஦்கா஡ ஢க்க படிபடண஢்பு 2  அடப Landscape or Portrait 
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3 
Adobe in Design ஧் ஢ஞி஢்஢குதி ஋஡்஦ா஧் ஋஡்஡?  

InDesign- ட஡ தடா஝ங்கித பி஦கு, திட஥தகட்தி஧் காஞ஢்஢டுண் ச஡்஡஧் 

திட஥கந் ண஦்றுண் ட஝ட்ுக்கநி஡் அடண஢்பு ஢ஞிட்டநண் (workspace) ஋஡஢்஢டுண். 

 

4 

In Design ஆபஞ ச஡்஡஧் திட஥ம௃஧் ஋து அபசிதணா஡து?  

முட஧் முட஦தாக InDesign-஍ தடா஝ங்குண் ட஢ாது டா஡டணபாக இ஝ண்த஢றுண் 

஢ஞிட்டநண் ‚Essentials‛ ஋஡஢்஢டுண். இது டணட஧ க஝ட்ு஢்஢ா஝ட்ு஢் ஢஧கண், 

இ஝஢்பு஦ண் கருவி஢்஢஧கண் ஆகிதப஦்று஝஡் InDesign ச஡்஡஧் திட஥ம௃஧் 

டடா஡்றுண்.திட஥ம௃஧் டடா஡்றுண் ச஡்஡஧்கந் ண஦்றுண் ஢஧கங்கந் ஆகிதப஦்றி஡் 

அடண஢்ட஢ ஢ஞிட்டநண் ஋஡஢்஢டுண். InDesign ஢ஞிட்டநண் பி஡்பருண் ஢குதிகடந 

சி஦஢்஢ண்சணாகக் தகாஞ்டுந்நது. ஆபஞ ச஡்஡஧் (Document Window), எ஝ட்ு 

஢஧டக (Paste Board), க஝ட்ு஢்஢ா஝ட்ு஢் ஢஧கண் (Control Panel), கருவி஢் ஢஧கண் (Tools 

panel) 

 

 

5 

In Design-஧் pasteboard ஋஡்஢து ஋஡்஡?  

எ஝ட்ு஢்஢஧டக (Pasteboard) ஋஡்஢து ஆபஞச ் ச஡்஡ட஧ச ் சு஦்றிம௅ந்ந சாண்஢஧் 

஠ி஦஢்஢குதி ஆகுண். எரு ஢க்கட்தி஧் அப஦்ட஦ச ் தசருகுபட஦்கு மு஡்பு 

எ஝ட்ு஢்஢஧டகம௃஧் உரு஢்஢டிகடந டபக்க஧ாண். ஠ாண் டசட஧ தசத்து 

தகாஞ்டிருக்குண் உறு஢்புகநி஡் ட஦்காலிக டசமி஢்பி஦்காக எ஝ட்ு஢்஢஧டகம௃஡் 

஢குதிகடந஢் ஢த஡்஢டுட்ட஧ாண். அ஠்ட ஢க்கட்திலிரு஠்து உறு஢்புகடநக் கிநிக் 

தசத்து இழுட்து வி஝ டபஞ்டுண் ண஦்றுண் ஠ணக்கு டடடபப஢்஢டுண் பட஥ அடப 

எ஝ட்ு஢்஢஧டகம௃஧் டங்கி இருக்குண். 

 

6 

Tool tip ஋஢்ட஢ாது டடா஡்றுண்? 

கருவி஢்஢஧கட்தி஧் கிநிக் தசத்தாண஧் ஌டடனுண் எரு கருவிம௃஡் மீது தசருகுண் 

புந்நிடத டபக்குண் த஢ாழுது tool tip டடா஡்றுண். இட஡் த஢தா ்ண஦்றுண் குறுக்கு 

பழி சாவி அட஝஢்புக்குறிக்குந் கா஝ட்ுண். 

 

7 

Paste tool – ஡் ஢த஡் ஋஡்஡? 

எரு ஆபஞட்தி஡் உந்டந ஢஧்தபறு ஢க்க அநவுகடந உருபாக்க ஢க்கக்கருவி 

஢த஡்஢டுகி஦து. Shift + P டத ஢க்க கருவிடதட் டடா஠்்தடடுக்க கிநிக் 

தசத்தவுண். இ஢்த஢ாழுது க஝ட்ு஢்஢ா஝ட்ு஢் ஢க்கட்தி஧் (Control Page) உந்ந 

டடாட்ப஢் ஢த஡்஢டுட்தி ஢க்க அடணடப ணா஦்஦வுண். 

 

8 

Zoomins ஋஡்஢து ஋஡்஡? 

InDesign-஧் உந்ந சி஧ ஢ஞிகளுக்கு, எரு த஢ாருடந அ஧்஧து த஢ாருநி஡் எரு 

஢குதிடத உதா ் உரு஢்த஢ருக்கண் அ஧்஧து த஢஥ிடாக்குட஧் மூ஧ண் 

஢ா஥ட்பம௃டுட஧்  டடடப஢்஢டுகி஦து. எரு ஆபஞட்தி஧் உந்ந எரு த஢ாருடந 

த஢஥ிடாக்கி (Zoom in) உ஦்று ட஠ாக்க த஢஥ிடாக்குட஧் அனுணதிக்கி஦ட. அ஠்ட஢் 

த஢ாருடந (Zoom Out) சிறிதடாக்கி வி஧கிச ் தச஡்று ஢ா஥க்்க சிறிடாக்குட஧் 

஢த஡்஢டுகி஦து. ஆபஞட்தி஧் உந்ந அட஡ட்டடம௅ண் எட஥ ட஠஥ட்தி஧் காஞ இது 

஢ாத஡்஢டுகி஦து. ஆபஞங்கடந஢் ஢ா஥ட்பம௃஝ 5% முட஧் 4000% பட஥ 

உரு஢்த஢ருக்க஧ாண் அ஧்஧து குட஦க்க஧ாண். 

 

 

9 

Tools panel-஍ தி஦க்க மூ஝ உந்ந ஢டி஠ிட஧கடந ஋ழுதுக. 

 Window → Tools ஍ட் டடா஠்்தடடுக்க கருவி஢் ஢஧கட்டட மூ஝஧ாண். இடட 

மீஞ்டுண் தி஦க்க Window → Tools ஍ ணறு஢டிம௅ண் டடா஠்்தடடுக்கவுண். அ஧்஧து 

 Tab சாவிடத அழுட்தி கருவி஢்஢஧கட்தி஧் உந்ந அட஡ட்து தி஦஠்ட 

஢஧கங்கடநம௅ண் மூ஝஧ாண். அ஠்ட ஢஧கங்கடந மீஞ்டுண் தி஦க்க Tab 

சாவிடத மீஞ்டுண் அழுட்டவுண். மிடடப கருவி஢் ஢஧கட்டடட மூடுபட஦்கு 

Close த஢஝்டிடதம௅ண் கிநிக் தசத்த஧ாண். 

 

10 

஢஠்திம௃஧் ஋ஞ் ப஥ிடச ண஦்றுண் பு஧்஧஝ ்குறிம௄டு உருபாக்க உடவுண் ஢டி஠ிட஧டத 

஋ழுதுக. 

எரு ஢ட்திக்கு பு஧்஧஝க்ந் அ஧்஧து ஋ஞ்கடநச ்டசாட்்ட஧் 

1. பு஧்஧஝் அ஧்஧து ஋ஞ்கந் டசாக்்க விருண்புண் ஢ட்திடதட் டடா஠்்தடடுக்கவுண். 

2. Type → Bulleted & Numbered Lists ஍ட் டடா஠்்தடடுக்கவுண், பி஦கு Apply Bullets 

அ஧்஧ட Apply Numbers ஍ கிநிக் தசத்தவுண். 
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஢குதி இ 

III எரு ஢டத்ிதநவி஧் விட஝தநிக்கவுண். 

1 

கருவி ஢஧கடட்ட (Tools Panel) ஢஦்றி வி஥ிபாக விநக்கவுண். 

கருவி஢்஢஧கண், டடா஠்்தடடு஢்புக் கருவிகந் (Selection tools), அடி஢்஢ட஝ 

படிபங்கடந பட஥பட஦்கா஡ கருவிகந், பட஥ட஧் ண஦்றுண் புது஢்பிட்ட஧் 

கருவிகந் (Drawing and Editing) ஢஥ிணா஦்஦஧் கருவிகந் (Transformation tools) உட஥ 

஢தி஢்பிட்ட஧் கருவிகந் (text editing tools) ஠காட்஧் கருவிகந் (Navifation tools) 

த஢ாருந் படிபடண஢்புக் கருவிகந் (Object formatting tools) ட஢ா஡்஦ப஦்ட஦க் 

தகாஞ்டுந்நது. டா஡டணபாக கருவி஢்஢஧கண், க஝ட்ு஢்஢ா஝ட்ு஢் ஢஧கட்தி஦்கு 

கீடன உந்நது. ஆபஞ ச஡்஡லி஡் இ஝து பு஦ண் உந்ந கருவி஢் ஢஧கட்தி஧் 

அட஡ட்ட கருவிகளுண் உந்நது. 

 

2 

கருவி ஢஧கடத்ி஧் (Tools panel) உந்ந ஌டடனுண் 3 கருவிகடந ஢஦்றி ஋ழுதுக. 

 டடா஠்்தடடு஢்புக் கருவி (Selection Tool (V Escape)) 

இது த஢ாருந்கடந அ஧்஧து த஢ாருந்கநி஡் தடாகுதிடத டடா஠்்தடடுக்க஢் 

஢த஡்஢டுகி஦து. V ஋஡்஦ த஢ாட்டாட஡ அழுட்தி இ஠்டக் கருவிடத 

டடா஠்்தடடுக்க஧ாண். 

 ட஠஥டி டடாவ்ு கருவி (Direct Selection tool (A)) 

இது எரு குழுவி஧் இரு஠்து எட஥ எரு த஢ாருடந டடா஠்்தடடுக்க (A டப 

அழுட்டவுண்) உடவுகி஦து. 

 ஢க்கக் கருவி (page tool) 

எரு ஆபஞட்தி஡் உந்டந ஢஧்டபறு ஢க்க அநவுகடந உருபாக்க 

஢க்கக்கருவி ஢த஡்஢டுகி஦து. 

 

 

3 

In Design-஧் உந்ந  View க஝஝்டநகந் தாடப? 

View ஢஝்டிம௃஧் உந்ந Zoom  க஝்஝டநகந் Zoom in, Zoom out, Actual Size, Fit page in 

window, Fit Spread in window ண஦்றுண் Entire Pasteboard 

 

4 

த஢஥ிடாக்குடலு஝஡் (Zooming) தடா஝ாப்ுட஝த சா஥ப்ுகளுக்கா஡ அட஡டத்ு 

விடச஢்஢஧டக குறுக்குபழிகடந ஢஦்றி ஋ழுதுக. 

Ctrl + = அழுட்டவுண் - த஢஥ிடாக்குட஧்  

Ctrl + - அழுட்டவுண் - சிறிடாக்குட஧்  

Ctrl + 1 ஢க்கட்டட அட஡் ச஥ிதா஡ அநவி஧் காணுட஧்  

Ctrl + 2 ஢க்கட்டட 200% அநவி஧் காணுட஧்  

Ctrl + 0 ஆபஞ ச஡்஡லி஧் முழு ஢க்கட்டடம௅ண் த஢ாருட்துட஧்  

Alt + Ctrl + ஆபஞ ச஡்஡லி஧் முழு ஢஥பட஧ம௅ண் த஢ாருட்துட஧்  

Ctrl + Spacebar (or)Ctrl + Alt + Spacebar ட஦்காலிகணாக Zoom  கருவிடத அணுகுட஧் 

(த஢஥ிடாக்க அ஧்஧து சிறிடாக்க) 

 

5 

஋ழுடத்ுக்கடந டணத஧ா஝ட்ு ண஦்றுண் கீதனா஝ட்ு ஋஡ ஋ப்பாறு ணா஦்றுபாத்? 

க஝ட்ு஢ா஝ட்ு ட஝்டி஧் இரு஠்து உட஥டத கீதனா஝ட்ு (Subscript) ண஦்றுண் 

டணத஧ா஝்஝ாக (Superscript) ணா஦்஦ 

1. கீதனா஝ட்ு அ஧்஧து டணத஧ா஝்஝ாக ணா஦்஦஢்஢஝ டபஞ்டித ஋ழுட்டட 

டடா஠்்தடடுக்கவுண். 

2. க஝ட்ு஢ா஝ட்ுட் ட஝்டி஧் உந்ந ஌டடனுண் எரு த஢ாட்டாட஡க் கிநிக் 

தசத்தவுண். டணத஧ா஝ட்ு (T2 
) கீதனா஝ட்ு (T2 ). 

3. டடாவ்ு தசத்த஢்஢஝்஝ ஋ழுட்து டடடப஢்஢டுண்஢டி ணாறுண். 

 

6 

எரு த஢ாருடந ஋஢்஢டி உருபாக்குபாத் ஋஡ வி஥ிபாக விப஥ி. 

சி஧ ட஠஥ங்கநி஧், ஠ணது ஢தி஢்பி஦்கு டடடப஢்஢டுண் எட஥ படக த஢ாருந் ஋நித 

படிபங்கநாகுண். படிபங்கந் ஆபஞட்டட஢் ஢ா஥஢்ட஦்கா஡ ஆ஥ப்ட்டடச ்

டச஥க்்கி஡்஦஡. இது உட஥க்கு பி஡்஡ஞி தாவுண் ஢ஞிதா஦்றுகி஦து.  

படிபங்கடந உருபாக்குண் கருவிகந் Rectangle, Ellipse ண஦்றுண் polygon ட஢ா஡்஦ 

கருவிகடநக் தகாஞ்டுந்நது. எரு படிப கருவிடதட் டட஥஠்்தடடுக்க, கருவிகந் 

஢஧கட்தி஧் Rectangle  கருவி (ட஦்஢த஢ாழுது டட஥஠்்தடடுட்ட படிப கருவி) மீது 

கிநிக் தசத்து சு஝த்஝லி த஢ாட்டாட஡ அழுட்தி பிடிட்டபாட஦,  ஠ாண் ஢த஡்஢டுட்ட 

விருண்புண் படிப கருவிடதட் டட஥஠்்தடடுக்க஧ாண்.  

படிப கருவி டட஥஠்்தடடுக்க஢்஢஝்஝ பி஡், ஆபஞட்தி஧் அடட இழு஢்஢ட஡் மூ஧ண் 

டகமுட஦தாக (manually) படிபட்டட உருபாக்க஧ாண். 
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7 

கருவி ஢஧கடத்ிலுந்ந ப஥஢஝ ச஝்஝ங்கந் ஋டட்ட஡? அடப தாடப? 

பட஥கட஧ ச஝்஝ங்கடந பட஥பட஦்கு கருவிகந் ஢஧கண் மூ஡்று கருவிகடநக் 

தகாஞ்டுந்நது. 

Ellipse ச஝்஝கண் இ஠்ட கருவிடத஢் ஢த஡்஢டுட்தி ஠ீந்ப஝்஝ (Oval) 

ண஦்றுண் ப஝்஝ (Round) ச஝்஝ங்கடந உருபாக்க஧ாண். 

Rectangle ச஝்஝கண் இ஠்ட கருவிடத஢் ஢த஡்஢டுட்தி தசப்பக ண஦்றுண் 

சது஥ ச஝்஝ங்கடந உருபாக்க஧ாண். 

Polygon ச஝்஝கண் இ஠்ட கருவிடத஢் ஢த஡்஢டுட்தி சண஢க்க ஢஧டகாஞ 

(equilateral polygon ச஝்஝ங்கடந உருபாக்க஧ாண்.  

 

 

஢குதி ஈ 

IV எரு ஢க்க அநவி஧் விட஝தநிக்கவுண். 

1 

InDesign-஧் புதித ஆபஞட்டட உருபாக்குபட஦்கா஡ ஢டி஠ிட஧கடந ஋ழுதுக. 

1. Start → All Programs → Adobe Indesign CC 2019 ஋஡்஢டட டடாவ்ு தசத்தவுண் 

(அ஧்஧து) திட஥முக஢்பி஧் உந்ந InDesign குறுக்கு பழிடதட் டடாவ்ு தசத்தவுண். 

2. Welcome to InDesign ஋஡்஦ ச஡்஡஧் திட஥ தி஦க்க஢்஢டுண். இ஢்த஢ாழுது Create New 

த஢ாட்டாட஡க் கிநிக் தசத்தவுண். 

3. இ஢்த஢ாழுது New Document window புதித ஆபஞ ச஡்஡஧் தி஦க்க஢்஢டுண். புதித 

ஆபஞட்டட உருபாக்குண் த஢ாழுது New Document  உட஥தா஝஧் த஢஝்டிம௃஧் 

஢஧ டடாவ்ுகடந த஢ாருட்துபட஦்கா஡ பாத்஢்பு கிட஝க்குண். புதித 

ஆபஞட்தி஧் அடி஢்஢ட஝ டடாவ்ுகடந த஢ாருட்துபட஦்கு. 

 New Document உட஥தா஝஧் த஢஝்டிம௃஧் Category டட்டலி஧் உந்ந print, web 

அ஧்஧து Mobile ஍ டடாவ்ு தசத்தவுண். 

பி஡்பருண் டடாவ்ுகடந ஌஦்க஡டப டடாவ்ு தசத்த஢்஢஝்஝ தடாகுதிம௃஧் 

குறி஢்பி஝வுண். 

Width and Hight :  ஆபஞட்தி஡் அநடப குறி஢்பிடுகி஦து. 

Units : ஆபஞட்டட அநவிடுபட஦்கா஡ அ஧டகக் குறி஢்பிடுகி஦து. 

Orientation : ஆபஞட்தி஦்கா஡ ஢க்க படிபடண஢்ட஢ (Landscape or Portrait) 

குறி஢்பிடுகி஦து. 

Pages : ஆபஞட்தி஧் உருபாக்க஢்஢டுண் ஢க்கங்கநி஡் ஋ஞ்ஞிக்டகடத 

குறி஢்பிடுகி஦து. 

Facing Pages : எரு ஢க்கட்டட ண஝ட்ுடண உட஝த ஆபஞட்டட உருபாக்குபட஦்கு 

஋டுட்துக்கா஝்஝ாக விநண்஢஥ங்கந், சுபத஥ா஝்டிகந், அ஧்஧து துஞ்டு 

பி஥சு஥ங்கந் ஆகிதப஦்றுக்கு Facing Pages-஍ Turn Off தசத்த டபஞ்டுண். 

புட்டகங்கந் ண஦்றுண் இடன்கந் ஆகிதப஦்றுக்கு Facing Pages ஍ Turn on தசத்த 

டபஞ்டுண். ஌த஡஡ி஧், இடப ப஧து, இ஝து அ஧்஧து மு஡், பி஡் ஋஡ இரு 

஢க்கங்கடநம௅ண் தகாஞ்டிருக்குண். 

Start # :  ஋஠்ட ஋ஞ்ஞி஧் ஆபஞண் தடா஝ங்குகி஦து ஋஡்஢டடக் 

குறி஢்பிடுகி஦து. டடா஠்்தடடுக்க஢்஢஝்஝ Facing Pages  உ஝஡் இ஥஝ட்஝஢் ஢ட஝ 

஋ஞ்கடந (அடாபது 2) ஋஡்஢டடக் குறி஢்பி஝்஝ா஧் ஆபஞட்தி஡ முட஧் ஢஥ப஧் 

இ஥ஞ்டு ஢க்க ஢஥பலு஝஡் தடா஝ங்குகி஦து. 

Primary Text Frame : முட஡்டண ஢க்கட்தி஧் (Mater Page) முக்கித உட஥டதச ்

டசாக்்க (Primary text) இ஠்டட் டடாட்ப டடா஠்்தடடுக்கவுண். 

Colums : ஆபஞட்தி஧் டசாக்்க஢்஢஝ டபஞ்டித த஠டுப஥ிடசகநி஡் (Column) 

஋ஞ்ஞிக்டகடதக் குறி஢்பி஝ ஢த஡்஢டுகி஦து. 

Column Gutter : த஠டுப஥ிடசகளுக்கு இட஝டத உந்ந இட஝தபநிம௃஡் 

அநடபக் குறி஢்பி஝ உடவுகி஦து. 

Margins : ஆபஞட்தி஡் எப்தபாரு ஢க்கட்தி஦்குண் எரு அநடப குறி஢்பி஝ 

஢த஡்஢டுகி஦து. ஢஧்டபறு ஢க்கங்களுக்கு ஢஧்டபறு ணதி஢்புகடந஢் 

஢த஡்஢டுட்துகி஦து. Chain ஢ஞிக்குறிடத கிநிக் தசத்பட஡் மூ஧ண் 

அநவுகடந பி஥ிக்க முடிம௅ண். 

Bleed and Slug : ஆபஞட்தி஡் எப்தபாரு ஢க்கட்தினு஝ட஡ Bleed and Sug இரு஢்பி஝ட்டட 

குறி஢்பிடுகி஦து. Chain ஢ஞிக்குறிடத கிநிக் தசத்பட஡் மூ஧ண் அநவுகடந பி஥ிக்க 

முடிம௅ண். 

4. மு஡்ட஢ இருட்ட஢்஢஝்஝ அடண஢்புகடநாடு ஆபஞட்டடட் தி஦க்க Create 

த஢ாட்டா஡்கடநக் கிநிக் தசத்தவுண். 
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சிறு குறி஢்பு ஋ழுதுக. 

஢த஡்஢ா஝ட்ு ஢஝ட்஝ (Application bar),  ஆபஞ டடட்஧் (Document Tab), கருவி ஢஧கண் 

(Tools Pannel) 
 

஢த஡்஢ா஝ட்ு ஢஝ட்஝ (Application bar)  

இது ஢ஞிட்டநட்தி஦்கு டண஧் உந்நது. இதி஧் ஢஧ ஢஝்டிகந் (menu) உந்ந஡.  எரு 

஢஝்டிடதட் தி஦க்க, ஢த஡்஢ா஝ட்ு ஢஝ட்஝ம௃஧் உந்ந ஢஝்டிம௃஡் த஢தட஥க் கிநிக் 

தசத்தவுண்.  எப்தபாரு ஢஝்டிம௅ண் ஢஝்டிபடகடதாடு தடா஝஥ப்ுட஝த 

க஝்஝டநகடந஢் ஢஝்டிதலிடுண் ஢஝்டி஢்த஢த஥க்நி஡் ப஧து஢்பு஦ட்தி஧் 

஢ஞிட்டநமுண் ண஦்றுண் View டட஥வ்ுகளுண் உந்ந஡. 
 

ஆபஞ டட்ட஧் (Document Tab)  

ஆபஞட் டட்ட஧், கிட஝ ண஝்஝ ரூ஧ருக்கு டண஧்஢குதிம௃஧் உந்நது. இது 

ஆபஞட்தி஡் த஢த஥,் உரு஢்த஢ருக்கட்தி஡் ஠ிட஧ (Magnification) ண஦்றுண் மூடு 

த஢ாட்டா஡் ஆகிதப஦்ட஦க் தகாஞ்டுந்நது. எ஡்றி஦்கு டண஦்஢஝்஝ ஆபஞங்கந் 

தி஦஠்திரு஠்டா஧், எப்தபாரு ஆபஞட்தி஦்குண் எரு டட்ட஧் டடா஡்றுண் ண஦்றுண் 

ஆபஞட் டட்ட஧்கந் கிட஝ண஝்஝ ப஥ிடசம௃஧் டடா஡்றுண்.ஆபஞட் டட்டட஧ 

கிநிக் தசத்து, அ஠்ட ஆபஞட்டடச ் ச஡்஡஧் திட஥ம௃஧் காஞ஧ாண். 

முழுடணதா஡ ச஡்஡஧் திட஥ம௃஧் ஆபஞட்டடட் தி஦க்க, ஆபஞட ் டட்டட஧ 

கிநிக் தசத்து இழுட்து குழுடப வி஝ட்ு தபநிடத஦்஦ டபஞ்டுண். 
 

கருவி ஢஧கண் (Tools Panel) 

InDesign-஧் இருக்குண் அட஡ட்து கருவிகளுண் இ஠்ட கருவிகந் ஢஧கட்தி஧் 

இருக்கி஡்஦஡.  த஢ாருடந உருபாக்குண் கருவிகந் (Rectangle  கருவி) த஢ாருடந 

உருணா஦்றுண் (Transforming) கருவிகந் (Rotate  கருவி), ஢க்க கா஝்சிடத ணா஦்றுட஧் 

ண஦்றுண் ஢ஞிட்டநட்தி஦்கு தச஧்லுட஧் கருவிகந் (Zoom  கருவி ண஦்றுண் Hand 

கருவி ) ஆகித கருவிகந் உந்ந஡.  சி஧கருவிகநி஡் கீன் ப஧து மூட஧ம௃஧் எரு 

சிறித முக்டகாஞண் இருக்குண்.  டணலுண் கூடுட஧ா஡ கருவிகந் அ஠்ட கருவிம௃஡் 

கீன் உந்ந஡. ஋஡்஢டட இ஠்ட முக்டகாஞண் குறிக்குண். கிநிக் தசத்து அழுட்தி 

பிடி஢்஢ட஡் மூ஧ண் ணட஦஠்திருக்குண் கருவிகடநக் காஞ஧ாண். 
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஢ாடடம௃஧் எரு படகம௃ட஡ உருபாக்க ஢டி஠ிட஧கடந ஋ழுதுக. 

எரு ஢ாடடக் கருவிம௃஧் ட஝்஝சச்ு தசத்பட஡் மூ஧ண், எரு ஢ாடடம௃஡் உந் 

அ஧்஧து தபநி஢்பு஦ விநிண்பி஧் ட஝்஝சச்ு டச஥க்்க஧ாண். ஢ாடடம௃஡் ஌கடனுண் எரு 

஢க்கட்தி஧் உட஥டதச ்டசச஥க்்க஧ாண். ஆ஡ா஧் இ஥ஞ்டு ஢க்கங்கநிலுண் டச஥க்்க 

முடிதாது. முடலி஧் உட஥டத உந் ஢க்க ஢ாடடம௃஧் டச஥ட்்திரு஠்டா஧் அடட பி஦கு 

தபநி஢்஢க்கணாக ஠க஥ட்்திக் தகாந்ந஧ாண். எரு ஢ாடடம௃஧் உட஥டதட் 

டட஥஠்்தடடுக்குண்ட஢ாது, அட஝஢்புக் குறிக்குந் டடா஡்றுண். அட஡் ஠ிட஧டதச ்

ச஥ிதசத்து உட஥டதச ்ச஥ிதசத்த஧ாண்.  

 

஢ாடடம௃஧் ட஝்஝சச்ு உருபாக்குட஧்  

1. கருவி஢் ஢஧கட்தி஧் ஢ாடடக்கருவிம௃஧் உந்ந ட஝்஝சட்ச டடட஥வ்ு தசத்தவுண்.  

2. ட஝்஝சட்ச டச஥க்்க ஢ாடடம௃஡் விநிண்பி஧் கிநிக் தசத்தவுண். (தி஦஠்து அ஧்஧து 

மூடி) உட஥ச ் ச஝்஝கட்தி஧் எரு எநிருண் தசருகுண் புந்நி டடா஡்றுண்.  

த஢ாருநி஧் உந்ந ஋஧்ட஧ ஠ீக்க஢்஢டுண்.  

3. ஌டடனுண் உட஥டதட் ட஝்஝சச்ு தசத்தவுண். உட஥ டா஡ாகடப ணடி஠்து 

உட஥சச்஝்஝கட்தி஦்கு ஌஦்஦பாறு அடணம௅ண். ‘Enter’ த஢ாட்டாட஡ அழுட்ட 

டபஞ்டிததி஧்ட஧.  

4. த஢ாருநி஡் விநிண்பி஧் ட஝்஝சச்ு டடா஡்றுண். ஋஧்ட஧கடந ஠ீக்கிவி஝ட்ு அட஡் 

படிபட்தி஧் உறுதிதாக அடணகி஦து.  

5. Overflow குறிம௄டு டடா஡்றி஡ா஧் உட஥சச்஝்஝கட்தி஡் டடாட்ப ஠ீக்கி, டட஥வ்ுக் 

கருவிடத கருவி஢்஢஧கட்தி஧் இரு஠்து டட஥வ்ு தசத்து உட஥சச்஝்஝கட்தி஧் எரு 

மூட஧ம௃஧் இழுக்கவுண்.  

6. டட஥வ்ுக்கருவிடத டட஥வ்ு தசத்தவுண் அ஧்஧து ட஝்஝சச்ு கருவிடத மீஞ்டுண் 

டட஥வ்ு தசத்தவுண். 
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ஆபஞடத்ி஧் உட஥ம௃ட஡ டபக்க ஢டி஠ிட஧கடந ஋ழுதுக. 

1. ஢஝்டி஢்஢஝ட்஝ம௃஧் இரு஠்து File →Place  ஍ டட஥வ்ு தசத்க.  

2. Place உடநதா஝஧் த஢஝்டி டடா஡்றுண்.  

3. இருட்ட஢்஢஝ டபஞ்டித உட஥க்டகா஢்ட஢ டட஥வ்ு தசத்து place உட஥தா஝஧் 

த஢஝்டிம௃஡் ப஧து ஢க்கட்தி஧் உந்ந Open  த஢ாட்டாட஡ கிநிக் தசத்தவுண்.  

4. தசருகுண் புந்நி தசறிவூ஝்஝஢்஢஝்஝ உட஥ தசருகுண் புந்நிதாக ணாறுகி஦து. இது 

ஆபஞட்தி஧் உட஥ தசருகுபட஦்கு டதா஥ாக உந்நது ஋஡்஢டட 

தட஥ிவிக்கி஦து.  

5. உட஥டத இருட்துபட஦்கு கிநிக் தசத்தவுண் (அடடட ஢க்கட்தி஧் 

தசருகுபட஦்கு) அ஧்஧து புதித உட஥சச்஝்஝கட்டட உருபாக்குபட஦்கு கிநிக் 

தசத்து இழுக்கவுண்.  

6. உட஥டத உட஥சச்஝்஝கட்தி஧் இருட்ட முடிதவி஧்ட஧ ஋஡ி஧், எரு சிப஢்பு + 

குறிதா஡து, உட஥சச்஝்஝கட்தி஡் கீன் ப஧து ஋஧்ட஧ம௃஧் Overflow குறிம௄஝ாக 

டடா஡்றுண்.  

7. இ஠்ட Overflow குறிம௄஝ட்஝ கிநிக் தசத்டா஧் மீடமுந்ந உட஥ தசருகுண் 

புந்நிம௃஧், கூடுட஧் உட஥சச்஝்஝கட்தி஧் உட஥டதச ் டச஥஢்்஢ட஦்காக 

஌஦்஦஢்஢டுகி஦து.  உட஥தா஡து கிநிக் தசத்ம௅ண் த஢ாழுது இருட்ட஢்஢டுண். 

கிநிக் தசத்து இழுட்டா஧் புதித உட஥சச்஝்஝கண் கூடுட஧் உட஥ம௅஝஡் 

உருபாக்க஢்஢டுண்.  புதித உட஥சச்஝்஝கண் மு஡்஡஥ ் உந்ந 

உட஥சச்஝்஝கட்து஝஡் இடஞக்க஢்஢டுண். இப்பாறு இடஞக்க஢்஢டுண்ட஢ாது 

உட஥ச஝்஝கட்தி஡் அநவு அ஧்஧து உட஥ம௃஡் படிவூ஝்஝஧் உட஥தா஡து 

இ஥ஞ்டு ச஝்஝கங்களுக்கு ணா஦்஦஢்஢஝்஝ா஧் இட஝டத ஋நிடாக ஠க஥க்ி஦து. 
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பட஥கட஧ ச஝்஝டத்ி஧் ஋ப்பாறு ஢஝டட்ட டசா஢்்஢ாத் ஢டி஠ிட஧கடந ஋ழுதுக. 

பட஥கட஧ ச஝்஝கண் பி஦ தண஡்த஢ாருந் ஠ி஥லி஧் உந்ந ஢஝ங்கடநட் டருவிக்க 

஢த஡்஢டுகி஦து.  ச஝்஝கட்தி஧் ஢஝ங்கடநச ்தசருக஧ாண்.  

1. பட஥கட஧ ச஝்஝கட்டட உருபாக்கு 00 

2. File →Place ஋஡்஢டடட் டட஥஠்்தடடுக்கவுண். Place உட஥தா஝஧் த஢஝்டி 

டடா஡்றுண்.  

3. ச஝்஝கட்தி஧் தசருக விருண்புண் ஢஝ட்டடக் கஞ்டுபிடிட்து டட஥஠்்தடடுக்கவுண்.  

4. Open மீது கிநிக் தசத்தவுண். 
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஢ா஝ண் - 3 

டகா஥஧்஝஥்ா 2018 (CorelDRAW 2018) 

஢குதி – அ 

 

I ச஥ிதா஡ விட஝டதட ்டடா஠்்தடடுடத்ு ஋ழுதுக. 

1 _________ ஋஡்஢து எரு தபக்஝஥ ்பட஥கட஧ ஢த஡்஢ா஝ாகுண்.  இ) Corel Draw  

2 
தபக்஝ா஥ ்பட஥கட஧தா஡து _________ தகாஞ்டு உருபாக்க஢்஢டுகி஡்஦து, அ) 

டகாடுகந் ண஦்றுண் பட஧வுகந் 
 

3 
_________ ஋஡்஢டப தசப்பக஢்஢஝ண் (raster image) ஋஡ அடனக்க஢்஢டுகி஡்஦஡.  ஆ) 

பி஝ட்ண஢்ஸ் 
 

4 
_________ ட஡ ஢த஡்஢டுட்தி ஠ீங்கந் தபக்஝ா஥ ்பட஥கட஧ம௃ட஡ உருபாக்க 

முடிம௅ண்.   இ) Corel Draw 
 

5 
தச஠்ட஥ கருவி஢்஢஝ட்஝க்கு (Stadard toolbar) அடுட்திரு஢்஢து _________  அ)  ஢ஞ்பு 

஢஝ட்஝ 
 

6 ஋஠்ட கருவி எரு த஢ாருநிட஡ டட஥வ்ு தசத்த உடவுகி஡்஦து?  இ) Pick கருவி  

7 ப஝்஝ட்டட பட஥த அ஠்ட கருவி உடவுகி஡்஦து. ஆ) Ellipse கருவி  

8 ஋ட்டட஡ படக சுருந்கந் உந்ந஡? இ)2  

9 _________ சாவிதா஡து Freehand  கருவிம௃ட஡ டட஥வ்ு தசத்த உடவுகி஡்஦து.  ஈ) F5  

10 
Corel Draw-வி஧் எரு ஆபஞட்டட மூ஝ _________ ட஡ அழுட்ட டபஞ்டுண். அ) Ctrl + 

F4 
 

11 Corel Draw வி஝ட்ு தபநிடத஦ Alt+F4  

12 _________ சாவி எரு த஢ாருடந டட஥வ்ு தசத்டடட ஠ீக்க உடவுகி஡்஦து. அ) ESC  

13 
_________ சாவி டசாண்ா஡ண் டட஥வ்ு தசத்த஢்஢஝்஝ த஢ாருநி஡் பி஥திம௃ட஡ 

உருபாக்க உடவுகி஡்஦து. அ) Ctrl +D 
 

14 
இடஞக்க஢்஢஝்஝ த஢ாருநிட஡ ட஡ிட்ட஡ிடத பி஥ிக்க _________ட஡ அழுட்டவுண்.  

அ) Ctrl+K 
 

15 
இ஥ஞ்டு அ஧்஧து அட஦்கு டண஦்஢஝்஝ த஢ாரு஝க்டந இடஞக்க _______ட஡ 

அழுட்டவுண்.   ஆ) Ctrl+L 
 

 

஢குதி - ஆ 

II மூ஡்று ப஥ிகநி஧் விட஝தநிக்கவுண். 

1 

Corel Draw ஋ட஦்காக ஢த஡்஢டுடட்஢்஢டுகி஡்஦து?  

CorelDraw ஋஡்஢து உத஥ட்஥ பட஥கட஧ சிட்தி஥ங்கந், ட஧ாடகா படிபடண஢்பு 

ண஦்றுண் ஢க்க அடண஢்புகடந உருபாக்குபட஦்கா஡ ஢஧்துட஦ பட஥கட஧ 

஢த஡்஢ாடு ஆகுண். 

 

2 

Corel Drawவி஧் எரு புதித ஆபஞடட்ட உருபாக்க ஢டி஠ிட஧கடந ஋ழுதுக.  

எரு புதித ஆபஞடட்ட உருபாக்க  

1. ப஥டப஦்பு திட஥ம௃஧் New Document த஢ாட்டாட஡ கிநிக் தசத்தவுண்.  

2. இ஢்ட஢ாது Create a New Document உட஥தா஝஧் த஢஝்டி டடா஡்றுண். இது 

ஆபஞட்தி஡் ஢஧ ஢ஞ்புகடந உந்நி஝ அனுணதிக்கி஦து.  

3. ஠ீங்கந் அதி஧் ஆபஞட்தி஦்கு த஢த஥ி஝வுண், ஢க்க அநவு அடணக்கவுண், 

CMYK அ஧்஧து RGB ட஢ா஡்஦ ஠ி஦ முட஦டணடதட் டட஥வ்ு தசத்தவுண், 

பஞ்ஞ ஠ி஥ங்கடநம௅ண் அடணக்க஧ாண்.  

4. OK த஢ாட்டாட஡ கிநிக் தசத்தவுண் 
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3 Corel Draw-வி஧் ஝ாக்க஥ ்(Docker) ஋஡்த஦ா஧் ஋஡்஡? 

஝ாக்க஥ ்(Docker) ஋஡்஢து குறி஢்பி஝்஝ கருவி அ஧்஧து ஢ஞிக்கா஡ க஝்஝டநகந் 

ண஦்றுண் அடண஢்புகடந தகாஞ்஝ எரு ச஡்஡஧் திட஥ அ஧்஧து சாந஥ண் ஆகுண். 

 

4 

Corel Draw விட஡ட ்தடா஝ங்குபட஦்கா஡ ஢டி஠ிட஧கடந ஋ழுதுக.  

஠ாண் CorelDRAW 2018 ட஠஥டிதாக ஠ணது கஞி஡ிம௃஡் திட஥முக஢்பி஧்  (Desktop) 

இரு஠்டடா அ஧்஧து Windows  தடா஝க்க ஢஝்டிம௃஧் (Start Menu) இரு஠்டடா 

தடா஝ங்க஧ாண்.  

1. Start → All Programs → CorelDRAW Graphics Suite 2018 → CorelDRAW2018 

஋஡்஢டட டடா஠்்தடடுக்கவுண் (அ஧்஧து)  

2. திட஥முக஢்பி஧், CorelDRAW 2018 குறுக்குவிடச குறுண்஢஝ட்டட 

கஞ்஝றிதவுண். இது எரு பஞ்ஞணதணா஡ ஢லூ஡் படிப குறுண்஢஝ண்.  

அட஡் கீன் CorelDRAW2018  ஋஡்று குறி஢்பி஝஢்஢஝்டிருக்குண். அடட஡ 

இ஥஝ட்஝க் கிநிக் தசத்து தி஦க்க஧ாண். 

 

5 

Corel Draw வி஧் எரு த஢ாருந் ஋஡்த஦ா஧் ஋஡்஡?  

கருவிகடந (tools) தகாஞ்டு ஠ாண் உருபாக்குண் பட஥஢஝ங்கந் த஢ாரு஝க்ந் 

஋஡஢்஢டுண். த஢ாருந் ஋஡்஢து ஢஝ண், படிபண், டகாடு, உட஥, படநவு, சி஡்஡ண், 

அ஧்஧து அடுக்கு ட஢ா஡்஦ பட஥஢஝ட்தி஡் எரு உறு஢்பு. 

 

6 

Corel Draw வி஧் ஢ஞ்பு ஢஝ட்஝ (Property Bar) ஋஡்த஦ா஧் ஋஡்஡?  

஢ஞ்பு஢்஢஝ட்஝ (Property bar) தச஠்ட஥ கருவி஢்஢஝்டிக்கு அடுட்து இருக்குண். இதக்க 

கருவிக்கு தடா஝஥ப்ுட஝த த஢ாதுபா஡ தசத஧்஢ாடுகடந இது கா஝ட்ுகி஦து. இது 

கருவி஢்஢஝்டிடத஢் ட஢ா஧ட் டடா஡்றி஡ாலுண், கருவி அ஧்஧து ஢ஞிடத஢் 

த஢ாருட்து ஢ஞ்புகந் ஢஝ட்஝ம௃஡் உந்ந஝க்கண் ணாறுகி஦து. 

 

7 

Corel Draw வி஧் ரூ஧ா ்(Ruler) ஌஡் ஢த஡்஢டுடட்஢்஢டுகி஡்஦து.  

சாந஥ட்தி஧் இ஥ஞ்டு ரூ஧஥ ்இருக்குண். அநப கிட஝ண஝்஝ ரூ஧஥ ்ண஦்றுண் 

தசங்குட்து ரூ஧஥.் அடப எரு ஆபஞட்தி஧் த஢ாரு஝்கநி஡் அநவு ண஦்றுண் 

஠ிட஧டத தீ஥ண்ா஡ிக்க ஢த஡்஢டுட்ட஢்஢டுகி஡்஦஡. 

 

8 

Corel Draw வி஧் கட஧டத்ி஦னுந்ந ஊ஝க கருவி (Artistic Media tool) ஌஡் 

஢த஡்஢டுடட்஢்஢டுகி஡்஦து?  

கட஧ தூ஥ிடக, தடநி஢்பு ண஦்றுண் calligraphic விடநவுகடந டச஥஢்்஢ட஦்கு 

஢த஡்஢டுகி஦து. 

 

9 

த஢ாரு஝க்டந குழுபாக்க ஢டி஠ிட஧கடந ஋ழுதுக.  

1. Pick கருவி தகாஞ்டு த஢ாருந்கடந டடாவ்ு தசத்தவுண். (஢஧ 

த஢ாருந்கடந டடாவ்ு தசத்த Shift சாவிம௃ட஡ அழுட்திதபாறு டடாவ்ு 

தசத்தவுண்.  

2. Object → Group → Group objects ஋஡்஢டட டடாவ்ு தசத்தவுண் (அ஧்஧து) Ctrl + 

G ட஡ அழுட்டவுண். டடாவ்ு தசத்த஢்஢஝்஝ த஢ாரு஝்கந் எட஥ த஢ாருநாக 

குழுபாக்க஢்஢டுண். 

 

10 

குழுபாக்க஢்஢஝஝் த஢ாருநி஡் குழுபாக்கடட்ட ஠ீக்க ஢டி஠ிட஧கடந ஋ழுதுக.  

1. Pick கருவி தகாஞ்டு குழுபாக்க஢்஢஝்஝ த஢ாருடந டடாவ்ு தசத்தவுண். 

2. ஢஝்டி஢஝ட்஝ம௃லிரு஠்து Object →Group → Ungroup Objects ஋஡்஢டட டடாவ்ு 

தசத்தவுண் (அ஧்஧து) விடச஢்஢஧டகம௃லுந்ந Ctrl + U ஋஡்஢டட 

அழுட்டவுண் அ஧்஧து Property ஢஝ட்஝ம௃லுந்ந Ungroup objects  ஋஡்஢டட 

கிநிக் தசத்தவுண். குழுபாக்க஢்஢஝்஝ த஢ாருநா஡து அடனுட஝த 

த஢ாரு஝க்நி஡் கூறுகநாக பி஥ிம௅ண் 
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஢குதி இ 

III எரு ஢டத்ிதநவி஧் விட஝தநிக்கவுண். 

1 

தபக்஝ா஥ ் பட஥கட஧க்குண் பி஝ட்ண஢்ஸ் (Bitmaps) குண் இட஝டத உந்ந 

டபறு஢ாடுகந் தாடப?  

தபக்஝஥ ் பட஥கட஧தா஡து (Vector graphics) டகாடுகந் ண஦்றுண் படநவுகந் 

தகாஞ்டு உருபாக்க஢்஢டுகி஡்஦து.  இடபகந் கஞிடட்தி஦்கு஥ித 

விநக்கங்கடந தகாஞ்டு உருபாக்க஢்஢டுகி஡்஦஡. இப்படகதா஡ 

பட஥கட஧தா஡து சி஡்஡ங்கந் ண஦்றுண் விநக்க஢்஢஝ங்கந் (Logos and illustrations) 

ஆகிதப஦்றி஦்கு ஌஦்஦டப ஆகுண்.  

பி஝்டண஢்ஸ் (Bitmaps) ஋஡்஢து தசப்பக஢்஢஝ண் (Raster images) ஋஡ 

அடனக்க஢்஢டுகி஡்஦து. இது ஢஝புந்நிகந் (Pixels) ஋஡ அடனக்க஢்஢டுண் சிறித 

சது஥ங்கடந தகாஞ்டு உருபாக்க஢்஢டுகி஡்஦து. 

 

2 

Corel Draw வி஧் எரு தசப்பகடட்ட பட஥ப஦்கு ஢டி஠ிட஧கடந ஋ழுதுக.  

1. எரு தசப்பகட்டட பட஥த கருவி஢்஢஝ட்஝ம௃஧் இரு஠்து Rectangle 

கருவிடத டடா஠்்தடடுக்கவுண். சு஝்டி சிறு சது஥ட்டட தகாஞ்஝ crosshair 

சு஝்டிதாக ணாறுண்.  

2. பட஥ட஧் ஢குதிம௃஧் ஋ங்கு டபஞ்டுடணா அங்கு கிநிக் தசத்து தகாஞ்டு 

இழுக்கவுண். ஠ாண் சு஝்டிடத இழுக்க , எரு தசப்பக டடா஡்றுண்.  

3. டடடபதா஡ அநவுந்ந தசப்பகண் டடா஡்றிதவு஝஡் சு஝்டி த஢ாட்டா஡் 

அழுட்துபடட வி஝ட்ுவி஝ டபஞ்டுண்.  

4. இ஢்ட஢ாது எரு தசப்பகண் திட஥ம௃஧் டடா஡்றுண். 

 

3 

Corel Draw வி஧் ப஝஝்ண் பட஥த ஢டி஠ிட஧கடந ஋ழுதுக. 

1. ப஝்஝ண் பட஥த ஠ீந்ப஝்஝ Ellipse கருவிடத கருவி஢஝ட்஝ம௃லிரு஠்து 

டடா஠்்தடடுக்கவுண். சு஝்டிம௃஡் படிபண் Crosshair குறிம௅஝஡் கீன்஢்஢குதிம௃஧் 

஠ீந்ப஝்஝ண் தகாஞ்டு குறிதாக இருக்குண்.  

2. இ஢்ட஢ாது பட஥ம௅ண் ஢குதிம௃஧் ஋ங்கு ப஝்஝ண் பட஥த டபஞ்டுண் அங்கு ctrl 

விடசடத அழுட்தி டபட்டபாறு சு஝்டிம௃஡் இ஝து த஢ாட்டாட஡ இழுட்து 

஠க஥ட்்ட டபஞ்டுண்.  

3. ஠ீங்கந் விருண்புண் ப஝்஝படிபண் டடா஡்றிதவு஝஡் சு஝்டிம௃஡் த஢ாட்டாட஡ 

அழுட்துபடட வி஝ட்ுவி஝வுண். 

 

4 

இ஥ஞ்டு படகதா஡ சுருந்கந் ஋஡்஢டப ஋஡்஡? விநக்குக.  

இ஥ஞ்டு படகதா஡ சுருந் படககந் உந்ந஡ . 

1. சணசீ஥ ்சுருந் (Symmetrical spiral)  

2. ண஝க்டக சுருந் (Logarithmic spiral)  

சணசீ஥ ்சுருந் முட஦ம௃஧் சுருந் சண அநவி஧் வி஥ிபட஝ம௅ண். ஋஡டப எப்தபாரு 

சுன஦்சிம௅ண் சண அநவுட஝த சுருடந உருபாக்குண். ண஝க்டக சுருந் 

முட஦ம௃஧் சுன஦்சி உருபாக்குண் சுருந்களுக்கிட஝டததா஡ தூ஥ண் 

அதிக஥ிட்டபாட஦ காஞ஢்஢டுண். ஠ாண் spiral கருவிடத தகாஞ்டு ஢஧ 

அநவுகநி஧் சுருந்கடந பட஥த முடிம௅ண்.  

 

5 

Flyout னுட஝த ஋஠்ட கருவிதா஡து ஠஝ச்டத்ி஥ கருவிம௃ட஡ 

தகாஞ்டிருக்குண்?  

Flyout ஡் Polygon tool ஠஝ச்ட்தி஥ கருவிடதக் தகாஞ்டிருக்குண். 

குறுக்குபழி சாவி Y ஆகுண்  

Polygon tool (Y) - Polygon, Star, Complex Star, Impact tool, GraphPaper, 

Spiral, Basic Shapes, ArrowShapes, Flowchart Shapes, BannerShapes 

ண஦்றுண் Callout Shapes கருவிகடந அணுக உடவுகி஦து. 

 

 

6 

Corel Draw வி஧் பிடனகடந ச஥ி தசத்த ஋஡்஡ தசத்த டபஞ்டுண்?  அடட஡ 

தசத்பட஦்தகா஡ விடச஢்஢஧டக குறுக்கு பழி ஋஡்஡?  

஠஝஢்பு அணாவ்ி஧் ஠ாண் மு஡்஡஥ ் தசத்ட தசத஧்஢ாடுகடந Corel Draw 

஠ிட஡வி஧் தகாஞ்டிருக்குண். மிக சமீ஢ட்தி஧் ஠ாண் தசத்ட தசதலி஧் 

ஆ஥ண்பிட்து, ஠ாண் பட஥ம௅ண் த஢ாழுது தசத்ட தசத஧்கடந ஋஧்஧ாண் 

உங்கநா஧் Undo தசத்த முடிம௅ண். எரு தசதட஧ Undo (தசத்டடட ஠ீக்கு) 

தசத்பதி஡ா஧் பருண் விடநவுகந் உங்களுக்கு பிடிக்கவி஧்ட஧ ஋஡ி஧் ஠ாண் 

அடட஡ Redo (ணறு஢டிம௅ண் தசத்) தசத்து தகாந்ந஧ாண்.  

To Undo, Redo and Repeat தசத஧்கந்  

எரு தசதட஧ Undo தசத்த  

Edit → Undo டடாவ்ு தசத்தவுண் (கட஝சி தசத஧்) (Ctrl + Z.) 
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எரு தசதட஧ Redo தசத்த  

Edit → Redo டடாவ்ு தசத்தவுண் (Ctrl+Shift +Z.) 

பட஥஢஝ட்தி஡் கட஝சிதாக டசமிக்க஢்஢஝்஝ ஠ிட஧க்கு பி஡்தச஧்஧  

File → Revert டடாவ்ு தசத்தவுண்.  

எரு தசதட஧ மீஞ்டுண் மீஞ்டுண் தசத்த  

Edit → Repeat டடாவ்ு தசத்தவுண். 

7 

எரு டகா஝ட்ிட஡ அண்புகுறிதாக ணா஦்றுபட஦்கு ஠ீங்கந் ஋஡்஡ தசத்வீ஥க்ந்?  

1. Freehand கருவி மூ஧ண் எரு டகாடு பட஥தவுண்.  

2. டகா஝ட்஝ டடா஠்்தடடுக்கவுண்.  

3. ஢ஞ்பு஢஝ட்஝ம௃஧் உந்ந End Arrow head Selector  கீடன இ஦ங்கு ஢஝்டித஢஝்டிம௃஧் 

கிநிக் தசத்தவுண். 

4. பி஡் டடடபதா஡ அண்புக்குறி முட஡டத டடாவ்ு தசத்தவுண். இ஢்ட஢ாது 

டகாடு அண்புக்குறிம௅஝஡் டடா஡்றுண். 
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எரு த஢ாருளுக்கு ஠ி஥஢்பு பஞ்ஞடட்டம௅ண் ண஦்றுண் ஋஧்ட஧க்டகா஝ட்ி஡் 

பஞ்ஞடட்டம௅ண் ஋ப்தபாறு குறி஢்பிடுபாத்?  

1. Pick கருவிடத ஢த஡்஢டுட்தி த஢ாருடநட் டடா஠்்தடடுக்கவுண்.  

2. பஞ்ஞட்ட஝்டி஧் ஌டாபது எரு பஞ்ஞட்டட கிநிக் தசத்தவுண்.  

3. டடா஠்்தடடுக்க஢்஢஝்஝ த஢ாருளுக்கு பஞ்ஞங்கந் டசா஠்்திருக்குண்.  

4. பஞ்ஞட்ட஝்டி஧் உந்ந ஌டாபது எரு பஞ்ஞட்தி஧் டபட்து ப஧து 

த஢ாட்டாட஡க் கிநிக் தசத்தவுண்.  

5. டடாத்டடுக்க஢்஢஝்஝ த஢ாருநி஡் பஞ்ஞண் டடா஠்்தடடுக்க஢்஢஝்஝ 

பஞ்ஞட்தி஦்கு ணாறிம௃ருக்குண்.  
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த஢ாரு஝க்நி஡் பி஥தி ண஦்றுண் த஢ாரு஝க்நி஡் ஠கலிம௃ட஡ ஋ப்பாறு 

உருபாக்குபாத்? இ஥ஞ்டி஦்குண் உந்ந டபறு஢ா஝ட்஝ ஋ழுடவுண்.  

 

டடாவ்ு தசத்த஢்஢஝஝் த஢ாருடந ஠க஧் ஋டுடட்஧்.  

஢஝்டி ஢஝ட்஝ம௃லிரு஠்து Edit →Dupilicate ஋஡்஢டட டடாவ்ு தசத்தவுண் அ஧்஧து 

விடச஢்஢஧டகம௃஧் Ctrl + D ஋஡்஢டட அழுட்டவுண். ஠க஧ா஡து அச஧் 

த஢ாருநி஡் டண஦்பு஦ ப஧து பு஦ட்திலிரு஠்து ச஦்று ஠க஥஠்்து கீன்கஞ்஝பாறு 

டடா஡்றுண். புதித ஠க஧ா஡து டா஡ாகடப டடாவ்ு தசத்த஢்஢஝ட்ு பருண்.  

 

த஢ாரு஝க்டந ஠கலி தசத்ட஧்(Cloning Obejects)  

டடாவ்ு தசத்த஢்஢஝்஝ த஢ாருநி஡் ஠கலி (Clone) டத உருபாக்க Edit → Clone 

஋஡்஢டட ஢஝்டி஢஝ட்஝ம௃லிரு஠்து டடாவ்ு தசத்தவுண். ஠கலிதா஡து அச஧் 

஢ாருநி஡் டண஦்பு஦ ப஧து பு஦ட்திலிரு஠்து ச஦்று ஠க஥஠்்து கீன்கஞ்஝பாறு 

டடா஡்றுண். புதித ஠க஧ா஡து டா஡ாகடப டடாவ்ு தசத்த஢்஢஝ட்ு விடுண். ஠கலி 

தசத்ட஧் பி஥தி ஋டுட்டலிரு஠்து டபறு஢஝்஝டாகுண். அச஧் த஢ாருநி஡் மீது 

தசத்த஢்஢டுண் அட஡ட்து ணா஦்஦ங்களுண் ஠கலி மீதுண் டா஡ாகடப 

தசத஦்஢டுட்ட஢்஢டுண்.  

஋டுட்துக்கா஝்஝ாக ஠ாண் அச஧் த஢ாருநி஡் ஠ி஥஢்பிடத (Fill) ணா஦்றுண் த஢ாழுது, 

஠கலிம௃னுட஝த ஠ி஥஢்பிம௅ண் ணாறுண்.  

 

10 

2. த஢ாருந்கடந தப஧்டிங் தசத்பட஡் மூ஧ண் ஋஡்஡ த஢஦ முடிம௅ண்? 

த஢ாருந்கடந தப஧்டிங் தசத்பட஦்கா஡ ஢டி஠ிட஧கடந ஋ழுதுக.  

தப஧்டிங் தசத்பட஡் மூ஧ண் எழுங்க஦்஦ படிபங்கடந ஠ாண் உருபாக்க 

முடிம௅ண். தப஧்டிங் தசத்த஢்஢஝்஝ த஢ாரு஝க்ந் கட஝சிதாக டட஥வ்ு 

தசத்த஢்஢஝்஝ த஢ாருநி஡் ஋஧்ட஧ டகா஝்டிட஡ம௅ண், ஠ி஥஢்புடட஧ம௅ண் ஋டுட்து 

தகாந்ளுண். தப஧்டிங் தசத்த஢்஢஝்஝ த஢ாரு஝க்டந மீஞ்டுண் ட஡ிட்ட஡ி 

த஢ாரு஝க்நாக ணா஦்றிதடணக்க Undo த஢ாட்டாட஡ ண஝ட்ுடண ஢த஡்஢டுட்ட 

முடிம௅ண்.  

Property ஢஝ட்஝ தகாஞ்டு த஢ாருந்கடந தப஧்டிங் தசத்த  

1. Pick கருவி தகாஞ்டு (அ஧்஧து) Shift சாவிம௃ட஡ அழுட்திதபாறு 

த஢ாருந்கடந டடாவ்ு தசத்தவுண்.  

2. Object → Shaping → Weld ஋஡்஦ க஝்஝டநம௃ட஡ ஢஝்டி஢஝ட்஝ம௃லிரு஠்து 

டடாவ்ு தசத்தவுண் (அ஧்஧து) Property ஢஝ட்஝ம௃லுந்ந Weld த஢ாட்டாட஡ 

கிநிக் தசத்தவுண்.  

3. த஢ாருந்கந் தப஧்டிங் தசத்த஢்஢஝ட்ு, எட஥ ஋஧்ட஧க்டகாடு தகாஞ்஝ 

த஢ாருநாக ணாறுண். 
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஢குதி – ஈ 

IV. எரு ஢க்க அநவி஧் விட஝தநிக்கவுண்.  

1 

சுருநிட஡ (Spiral) பட஥த ஢டி஠ிட஧கடந ஋ழுதுக.  

சுருந் பட஥த  

1. ஢஧டகாஞ கருவிம௃஡் மீது அழுட்தி஢் பிடிட்டபாட஥ இரு஠்டா஧் flyout ஢஝்டி 

டடா஡்றி டணலுண் ஢஧ கருவிகடந கா஝ட்ுண்.  

2. flyout ஢஝்டிம௃஧் உந்ந சுருந் (Sprial) கருவிடத கிநிக் தசத்தவுண்.  

3. ஠ாண் ஢ஞ்பு ஢஝ட்஝ம௃஧் உந்ந சுருந் சுன஦்சி த஢஝்டிம௃஧் 

஋ஞ்ஞிக்டகடத தகாடு஢்஢ட஡் மூ஧ண் டடடபதா஡ ப஝்஝ண் உட஝த 

புதித சுருந் அடண஢்ட஢ உருபாக்க முடிம௅ண்.  

4. பி஡் ஢ஞ்பு஢஝ட்஝ம௃஧் கீன்கஞ்஝ ஌டடனுண் எரு த஢ாட்டாட஡ கிநிக் 

தசத்தவுண்.  

 சணசீ஥ ்சுருந் (Symmetrical spiral)  

 ண஝க்டக சுருந் (Logarithmic spiral)  

சுன஦்சிடத தபநி஢்பு஦ணாக ஠க஥ட்்துண் ட஢ாது சுருந் வி஥ிபாக்க 

அநவுகடந ணா஦்஦ விருண்பி஡ா஧் spiral expansion slider ஍ ஠க஥ட்்டவுண்.  

பட஥ம௅ண் ச஡்஡஧் திட஥ம௃஧் ஠ணக்கு டபஞ்டித அநவு உந்ந சுருந் பருண் 

பட஥ சு஝்டிடத கிட஝ ண஝்஝ணாக இழுக்கவுண்.  

 

2 

஢஧டகாஞங்கடந (Polygon) டத ஢டி஠ிட஧கடந ஋ழுதுக.  

1. ஢஧டகாஞ உருபண் பட஥த (஍ங்டகாஞண் - ஍஠்து ஢க்கண் உட஝த உருபண் 

஋஡்றுண் அறித஢்஢டுகி஦து) polygon கருவிடத கருவி஢஝ட்஝ம௃லிரு஠்து 

டடா஠்்தடடுக்கவுண். சு஝்டிம௃஡் படிபண் Crosshair குறிம௅஝஡் கீன்஢்஢குதிம௃஧் 

஢஧டகாஞண் தகாஞ்஝ குறிதாக இருக்குண்.  

2. இ஢்ட஢ாது பட஥ம௅ண் ஢குதிம௃஧் ஋ங்கு ஍ங்டகாஞண் பட஥த டபஞ்டுடணா 

அங்கு சு஝்டிம௃஡் இ஝து த஢ாட்டாட஡ அழுட்தி பிடிட்டபாறு ஠க஥ட்்ட 

டபஞ்டுண்.  

3. ஠ாண் விருண்புண் படிபமுட஝த முக்டகாஞண் உருபா஡வு஝஡் சு஝்டிம௃஡் 

த஢ாட்டாட஡ அழுட்துபடட வி஝ட்ு வி஝வுண்.  

4. படந஠்ட ஢஧டகாஞட்தி஡் ஢க்கங்கடந அதிக஥ிக்க ஠ாண் படந஠்ட 

஢஧டகாஞட்டட pick கருவி மூ஧ண் டடா஠்்தடடுக்கவுண்.  

5. சு஝்டிடத ஢ஞ்பு஢஝ட்஝ம௃஧் உந்ந Number of Points on Polygon 

உட஥஢்த஢஝்டிம௃஧் கிநிக் தசத்து டடடபதா஡ ஢க்கங்கநி஡் 

஋ஞ்ஞிக்டகடத தகாடுக்கவுண்.  
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Corel Draw வி஧் ஋ப்பாறு எரு ஠஝ச்டத்ி஥டட்ட உருபாக்குபாத்?  

஠஝ச்டத்ி஥ண் பட஥ட஧்  

polygon கருவிம௃஡் கீன்஢்஢குதிம௃஧் சிறித அண்புக்குறி உந்நது. இ஠்ட அண்புகுறி 

flyout உந்நடட உஞ஥ட்்துகி஦து ஠஝்சட்தி஥ண் பட஥த  

1. ஢஧டகாஞ கருவிம௃஡் மீது அழுட்திக்தகாஞ்ட஝ இரு஠்டா஧் flyout ஢஝்டி 

டடா஡்றி டணலுண் ஢஧ கருவிகடந கா஝ட்ுண்.  

2. flyout ஢஝்டிம௃஧் உந்ந ஠஝ச்ட்தி஥க் கருவிடத கிநிக் தசத்தவுண்.  

3. பட஥ம௅ண் ஢குதிம௃஧் ஋ங்கு ஠஝ச்ட்தி஥ண் பட஥தடபஞ்டுடணா அங்கு 

சு஝்டிம௃஡் இ஝து த஢ாட்டாட஡ அழுட்தி பிடிட்டபாறு இழுட்து ஠க஥ட்்டவுண். 

4. ஠஝ச்ட்தி஥ உருபண் உருபா஡வு஝஡் சு஝்டிம௃஡் த஢ாட்டாட஡ அழுடத்ுபடட 

வி஝ட்ு வி஝வுண்.  
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க஝஝்ங்கடந (Grid) பட஥த ஢டி஠ிட஧கடந ஋ழுதுக.  

க஝஝்ங்கந் பட஥ட஧்  

Graph Paper கருவிடத ஢த஡்஢டுட்தி ஠ாண் குறி஢்பி஝்஝ ஋ஞ்ஞிக்டக ப஥ிடச 

ண஦்றுண் த஠டுப஥ிடசகடந தகாஞ்஝ எரு க஝்஝கண் பட஥த஧ாண். க஝்஝கண் 

஋஡்஢து ட஡ிட்ட஡ிதாக பி஥ிக்கக்கூடித ஢஧ தசப்பகங்கந் டச஥஠்்ட 

அடண஢்஢ாகுண்.  

எரு க஝்஝கண் பட஥த  

1. ஢஧டகாஞ கருவிம௃஡் மீது அழுட்திக் தகாஞ்ட஝ இரு஠்டா஧் flyout ஢஝்டி 

டடா஡்றி டணலுண் ஢஧ கருவிகடந கா஝ட்ுண்.  

2. flyout ஢஝்டிம௃஧் உந்ந Graph Paper கருவிடத கிநிக் தசத்தவுண்.  

3. ஢ஞ்பு஢஝ட்஝ம௃஧் உந்ந டண஧் ண஦்றுண் கீன்஢்஢குதிம௃஧் த஠டுப஥ிடச ண஦்றுண் 

ப஥ிடசகநி஡் ஋ஞ்ஞிக்டகடத உந்நி஝வுண். தக஧் ஢குதிம௃஧் 

உந்நி஝஢்஢டுண் ணதி஢்பு த஠டுப஥ிடச ஋ஞ்ஞிக்டகடதம௅ண் கீன்஢்஢குதிம௃஧் 
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உந்நி஝஢்஢டுண் ணதி஢்பு ப஥ிடச ஋ஞ்ஞிக்டகடதம௅ண் குறிக்குண். 

4. பட஥ம௅ண் ஢குதிம௃஧் ஋ங்கு க஝்஝கண் டடா஡்஦ டபஞ்டுடணா அங்கு கிநிக் 

தசத்தவுண்.  

5. சு஝்டிடத கிட஝ண஝்஝ணாக இழு஢்஢ட஡் மூ஧ண் டபஞ்டித க஝்஝கண் பட஥த 

முடிம௅ண்.  

6. டணத஢் புந்நிம௃லிரு஠்து தபநி஢்பு஦ணாக க஝்஝ங்கந் பட஥த shift  

விடசடத அழுட்திதபாறு ஠க஥ட்்ட கபஞ்டுண்.  க஝்஝ங்கடந சது஥ படிவி஧் 

அடணக்க Ctrl விடசடத அழுட்திதபாறு ஠க஥ட்்ட டபஞ்டுண். 

5 

஢ாடடம௃஧் உடணம௃ட஡ த஢ாருடத்ுட஧் ஢஦்றி வி஥ிபாக ஋ழுது.  

஋஠்ட படிப ஢ாடடம௃லுண் உட஥ ச஥ட்டட த஢ாருட்ட Corel Draw அனுணதிக்கி஡்஦து. 

அது ட஠஥ ் அ஧்஧து பட஥஠்ட டகாடு, எரு தசப்பகண், எரு ஠ீந்ப஝்஝ண் அ஧்஧து 

ண஦்த஦ாரு ஋ழுட்து அ஧்஧து உட஥ ச஥ண் ஋஡ ஢஧படிப ஢ாடடகநாக இருக்க஧ாண். 

உட஥ம௃ட஡ ஢ாடடம௃஧் த஢ாருடத்ுபட஦்கு Text ஢஝்டிம௃லிரு஠்து Fit text to path 

க஝்஝டநம௃ட஡ ஢த஡்஢டுட்டவுண்  

உட஥ம௃ட஡ ஢ாடடம௃஧் த஢ாருட்துட஧்  

1. Pick கருவி ண஦்றுண் Shift சாவி தகாஞ்டு உட஥ த஢ாருடநம௅ண் ண஦்றுண் 

இ஥ஞ்஝ாபது த஢ாருடநம௅ண் டட஥வ்ு தசத்தவுண்.  

2. Text ஢஝்டிம௃லிரு஠்து Fit + Text to path ஋஡்஢டட டட஥வ்ு தசத்தவுண்.  

3. இ஥ஞ்஝ாபது த஢ாருநி஡் ஢ாடடம௃஡் பழி உட஥தா஡து மீஞ்டுண் 

பட஥த஢்஢டுகி஡்஦து. 
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஢ா஝ண் 4 

஢஧்லூ஝கண் ண஦்றுண் கஞி஢்த஢ாறி஢் ஢தி஢்஢கண் 

 

஢குதி – அ 

I ச஥ிதா஡ விட஝டதட ்டட஥஠்்தடடுடத்ு ஋ழுதுக 

1 

_________ ஋஡்஢டட எ஡்றி஦்கு டண஦்஢஝்஝ ஊ஝க படகதா஡ உட஥, திட஥கட஧, 

எநிக்கா஝்சி, அடசவூ஝்஝஧் ண஦்றுண் எலி ஆகிதப஦்றி஧் ஌டடனுண் எரு 

படக஢்஢த஡்஢ா஝ட்஝க் குறிக்குண்.  இ) ஢஧்லூ஝கண் 

 

2 ஢஧்லூ஝கட்தி஡் குட஦஢ாடுகநி஧் எ஡்று அடனுட஝த _________  அ) விட஧  

3 வி஥ிபாக்கண் JPEG ஆ) Joint Photographic Experts Group  

4 
஢஧்லூ஝கட்டட உருபாக்க ஠ணக்கு டடடபதா஡டப ப஡்த஢ாருந், 

தண஡்த஢ாருந் ண஦்றுண் _________   ஈ) ஠ி஥஧ாக்க தி஦஡் 
 

5 

ச஥ிதா஡ எ஡்ட஦ட் டட஥஠்்தடடுட்து பி஡்பருப஡ப஦்ட஦ த஢ாருட்துக.  

1. உட஥ - TGA  

2. ஠ின஦்஢஝ண் - MIDI  

3. எலி - MPEG  

4. எநி - RTF  

இ) 4, 1, 2, 3 

 

6 பி஡்பருப஡ப஦்றி஧் த஢ாரு஠்டாட எ஡்ட஦க் கஞ்டுபிடிக்கவுண்.  இ) RTF  

7 
_________ ஋஡்஢து அடசதா ஠ின஦்஢஝ங்கடந தடா஝஥ச்ச்ிதா஡ இதக்கணாக 

கா஝்சி஢்஢டுட்துண் தசத஧்.  ஈ) அடசவூ஝்஝஧் 
 

8 
இநஞதட்தி஡் மூ஧ண் ஠ிகன்ட஠஥ ஠ிகன்சச்ிகடந ட஠஥டிதாக எநி஢்஢஥஢்புபடட 

_________ ஋஡்கிட஦ாண்.  அ) பட஧ எநி஢்஢஥஢்பு 
 

9 GIF ஢த஡்஢டுட்துண் பஞ்ஞ டட஝஧் அ஝்஝படஞ _________ அ) 8 பி஝ ்  

10 RTF டகா஢்பு படிபட்டட அறிமுக஢்஢டுட்திதது _________ ஆ) Micorsoft  

 

஢குதி – ஆ 

II மூ஡்று ப஥ிகநி஧் விட஝தநிக்கவுண் 

1 

பட஥தறு – ஢஧்லூ஝கண் ண஦்றுண் அட஡் சி஦஢்஢ண்சண்.  

஢஧்டபறு பநங்கநா஡ ஠ின஦்஢஝ண், உட஥, பட஥கட஧, எநிக்கா஝்சி, எலி ண஦்றுண் 

எநி ஆகிதப஦்ந஦ எ஡்றிடஞட்து, ட஥வுகடந எ஦்ட஦ட்டநட்தி஦்கு ணா஦்஦ 

஢த஡஥க்ளுக்கு ஢஧்லூ஝கண் அனுணதி அநிக்கி஦து. 

 

2 

஢஧்லூ஝க கூறுகடந஢் ஢஝ட்ிதலிடுக.  

஢஧்லூ஝கண் 5 முக்கித கூறுகடநக் தகாஞ்டுந்நது. அடப உட஥,  ஠ின஦்஢஝ண், 

எலி,  எநிக்கா஝்சி ண஦்றுண் அடசவூ஝்஝஧். 

 

3 

஢஧்லூ஝கடத்ி஧் உட஥ (Text) கூறிட஡ படக஢்஢டுடத்ுக.  

஠ிட஧தா஡ உட஥ (Static text)  

எரு டட஧஢்பிடநா அ஧்஧து எரு ப஥ிம௃ட஧ா அ஧்஧து எரு ஢ட்திம௃ட஧ா, உட஥ 

அ஧்஧து தசா஧் ணா஦ாண஧் இரு஠்டா஧் அது ஠ிட஧தா஡ உட஥ ஆகுண்.  

மீ உட஥ (hypertext)  

மீஉட஥ ஋஡்஢து முட஡தண், உட஥ ண஦்றுண் முட஡தங்களுக்கு இட஝டததா஡ 

இடஞ஢்பு ஆகிதப஦்ட஦க் தகாஞ்டிருக்குண் அடண஢்஢ாகுண். 

 

4 

஢஧்லூ஝கடத்ி஧் ஠ிட ஦்஢஝கூறிந஡ பநக஢்஢டுடத்ுக  

பி஝ட்ண஢் அ஧்஧து தசப்பக ஢஝ங்கந் (Bit mapor Raster image)   

கஞி஡ிம௃஧் ஢஝ங்கடநச ் டசமிக்குண் த஢ாதுபா஡ ண஦்றுண் ஢஥஠்ட படிபண் 

பி஝்டண஢் அ஧்஧து தசப்பக ஢஝ணாகுண். பி஝்டண஢் ஋஡்஢து ஢஝஢்புந்நி (pixel) 

஋஡்஦டனக்க஢்஢டுண் சிறித புந்நிகநி஡் ஋நித அஞிதாகுண். 

டபக்஝஥ ்஢஝ங்கந் (Vector images)  

பட஥ம௅ண் கூறுகநா஡ அ஧்஧து த஢ாருந்கநா஡ ப஥ிகந், தசப்பகங்கந், 

ப஝்஝ங்கந் ண஦்றுண் ஢஧ ஢஝ங்கடந உருபாக்குபது தபக்஝஥ ் ஢஝ங்கநி஡் 

அடி஢்஢ட஝ம௃஧் அடணம௅ண்.  
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5 
பட஥தறு – அடசவூ஝்஝஧் ண஦்றுண் அட஡் சி஦஢்஢ண்சண்.  

அடசதா ஢஝ங்கடந (Still images) மிக விட஥பாக காஞ்பி஢்஢ட஡் மூ஧ண் 

அப஦்ட஦ தடா஝஥ச்ச்ிதா஡ அடசவு ட஢ா஡்஦ உஞ஥ட்ச தகாடுக்குண் தசதட஧ 

அடசவூ஝்஝஧் ஆகுண். அடசவூ஝்஝஧், திட஥த஢ாருந் ஋஡்஢து எரு தபக்஝஥ ்

஢஝ணாகுண்.  ஋ஞ் ணா஦்஦ட்டட஢் ஢த஡்஢டுட்தி எருங்கிடஞ஢்புகடந (Coordinates) 

பட஥தறுக்க ஢஝ட்து஝஡் அட஡் ஢ாடடம௃஡் இதக்கண் கஞக்கி஝஢்஢டுண். 

இ஥ஞ்டு படகதா஡ அடசவூ஝்஝஧்கநாப஡:  ஢ாடட அடசவூ஝்஝஧் (path 

animation) ண஦்றுண் ச஝்஝கண் அடசவூ஝்஝஧் (Frame animation).  

 

6 

஠ின஦்஢஝ டகா஢்பு படிபங்கடந஢் ஢஝ட்ிதலிடுக.  

1. TIFF(Tagged Image File Format)   2. BMP(Bitmap)  3. DIB(Device IndependentBitmap)  

4. GIF(Graphics Interchange Format)    5. JPEG(Joint Photographic Experts Group) 6. TGA(Tagra)  

7. PNG(Portable Network Graphics)  

 

7 

எநி டகா஢்பு படிபங்கடந஢் ஢஝ட்ிதலிடுக.  

1. WAV(Waveform Audio File Format)   2. MP3(MPEG layer-3 Format)       3. OGG 4. AIFF(Audio 

Interchange File Format)   5. WMA(Windows Media Audio)   6. RA(Real Audio Format) 

 

8 
எநிக்கா஝ச்ி டகா஢்பு படிபங்கடந஢் ஢஝ட்ிதலிடுக.  

1.AVI(Audio/Video Interleave) 2. MPEG(Moving Picture Experts Group)  
 

9 

பட஥தறு – ஢஧்லூ஝க உருபாக்கண்.  

஢஧்லூ஝கட்டட உருபாக்குபட஦்கு ட஢ாதுணா஡ ட஠஥ண் ண஦்றுண் தி஦டணதா஡ 

தி஝்஝மி஝஧் ஆகிதடப டடடப஢்஢டுகி஡்஦஡. இது தி஝்஝஢்஢ஞி சுமூகணாக 

தடா஝஥வுண் ண஦்றுண் டகப஧் இ஧க்கு ஢ா஥ட்பதாந஥க்டநச ்தச஡்஦ட஝தவுண் 

உறுதிதசத்கி஦து. 

 

10 

஢஧்லூ஝க உருபாக்க குழு உறு஢்பி஡஥க்டந ஢஝்டிதலிடுக.  

1. டதா஥ி஢்பு டண஧ாந஥ ்2. த஢ாருந஝க்க ப஧்லு஠஥ ்3. ஸ்கி஥ி஢்஝் ஋ழுட்டாந஥ ்4. 

உட஥ ஢தி஢்஢ாந஥ ்5. ஢஧்லூ஝க படிபடண஢்஢ாந஥ ்6. கஞி஡ி பட஥கட஧ 

கட஧ஜ஥ ்7. எலி ண஦்றுண் எநிக்கா஝்சி ப஧்லு஠஥ ்8. கஞி஡ி ஠ி஥஧஥ ்9. பட஧ 

ப஧்லு஠஥.் 

 

 

஢குதி இ 

III எரு ஢டத்ிதநவி஧் விட஝தநிக்கவுண். 

1 

஢஧்லூ஝க கூறுகடந சுருக்கணாக விப஥ி.  

஢஧்லூ஝கண் உட஥,  ஠ின஦்஢஝ண், எலி, எநி ண஦்றுண் அடசவூ஝்஝஧் ஆகித ஍஠்து 

முக்கிதக் கூறுகடநக் தகாஞ்டுந்நது.  

Dynamic Elements:Video,Animation,Audio  

Static Elements:Text,Graphics  

 

2 

அடசவூ஝்டி஡் சி஦஢்஢ண்சங்கந் ண஦்றுண் தடாழி஧் த௃஝஢்ங்கடந விப஥ிக்கவுண்.  

அடசதா ஢஝ங்கடந (Still images) மிக விட஥பாக காஞ்பி஢்஢ட஡் மூ஧ண் 

அப஦்ட஦ தடா஝஥ச்ச்ிதா஡ அடசவு ட஢ா஡்஦ உஞ஥ட்ப தகாடுக்குண் தசதட஧ 

அடசவூ஝்஝஧் ஆகுண். அடசவூ஝்஝லி஧், திட஥த஢ாருந் ஋஡்஢து எரு தபக்஝஥ ்

஢஝ணாகுண். ஋ஞ் ணா஦்஦ட்டட஢் ஢த஡்஢டுட்தி எருங்கிடஞ஢்புகடந (Coordinates) 

பட஥தறுக்க ஢஝ட்து஝஡் அட஡் ஢ாடடம௃஡் இதக்கண் கஞக்கி஝஢்஢டுண். 

இ஥ஞ்டு படகதா஡ அடசவூ஝்஝஧்கநாப஡: ஢ாடட அடசவூ஝்஝஧் (path animation) 

ண஦்றுண் ச஝்஝கண் அடசவூ஝்஝஧் (Frame animation).  

 

3 

உருபாக்க குழு உறு஢்பி஡஥க்நி஡் ஢ஞிகந் ண஦்றுண் த஢ாறு஢்புகடந஢் ஢஦்றி 

஋ழுதுக.  

஢஧்லூ஝க உருபாக்கட்தி஧் அதிக஢஝ச் ஢஧ட஡ உத஥ட்஥ தி஦டணம௅஝஡் த஢றுண் 

படகம௃஧் குழு உறு஢்பி஡஥க்டந டண஧ாஞ்டண தசத்பது க஝்஝ாதணாகுண். ஠஧்஧ 

ட஥ணா஡ உத஥஠்்ட ஢஧்லூ஝க உருபாக்க ஢த஡்஢ா஝்டி஦்கு பி஡்பருண் 

உறு஢்பி஡஥க்டநக் தகாஞ்஝ ப஧்லு஠஥ ்குழு டடடப஢்஢டுகி஦து.  

1. டதா஥ி஢்பு டண஧ாந஥ ்2. த஢ாருந஝க்க ப஧்லு஠஥ ்3. ஸ்கி஥ி஢்஝் ஋ழுட்டாந஥ ்4. 

உட஥ ஢தி஢்஢ாந஥ ்5. ஢஧்லூ஝க படிபடண஢்஢ாந஥ ்6. கஞி஡ி பட஥கட஧ 

கட஧ஜ஥ ்7. எலி ண஦்றுண் எநிக்கா஝்சி ப஧்லு஠஥ ்8. கஞி஡ி ஠ி஥஧ா ்9. பட஧ 

ப஧்லு஠஥ ் 
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஢஧்லூ஝கடத்ி஧் உந்ந ஢஧்டபறு டகா஢்பு படிபங்கந் ஢஦்றி விப஥ிக்கவுண்.  

உட஥ படிபங்கந்  

1. RTF(Rich Text Format) 2. Plain Text  

஠ின஦்஢஝ படிபங்கந்  

1.TIFF (Tagged Image File Format)  2. BMP (Bitmap) 3. DIB (Device IndependentBitmap) 4. GIF 

(Graphics Interchange Format)   5. JPEG (Joint Photographic Experts Group)   6. TGA (Tagra)    

7. PNG (Portable Network Graphics)  

இ஧க்க எலி டகா஢்பு படிபங்கந்  

1.WAV (Waveform Audio File Format)     2. MP3 (MPEG layer-3 Format)    3. OGG  4. AIFF 

(Audio Interchange File Format) 5. WMA (Windows Media Audio)    6. RA (Real Audio Format)  

இ஧க்க எநிக்கா஝ச்ி டகா஢்பு படிபங்கந்  

1.AVI(Audio/Video Interleave) 2. MPEG(Moving Picture Experts Group)   

 

 

஢குதி – ஈ 

IV எரு ஢க்க அநவி஧் விந஝தநிக்கவுண்  

1 

஢஧்லூ஝க தசத஧்கந் ஢஦்றி வி஥ிபாக விநக்கவுண்.  

஢஧்லூ஝கட்டட உருபாக்குபட஦்கு ட஢ாதுணா஡ ட஠஥ண் ண஦்றுண் தி஦டணதா஡ 

தி஝்஝மி஝஧் ஆகிதடப டடடப஢்஢டுகி஡்஦஡.  இது தி஝்஝஢்஢ஞி சுமூகணா 

தடா஝஥வுண் ண஦்றுண் டகப஧் இ஧க்கு ஢ா஥ட்பதாந஥க்டநச ் தச஡்஦ட஝தவுண் 

உறுதி தசத்கி஦து. சிக்க஧ா஡ ஢஧்லூ஝க தி஝்஝ங்கடந உருபாக்குபட஦்கா஡ 

஢டி஠ிட஧கந் பி஡்பருணாறு.  

1. கருட்துரு ஢கு஢்஢ாத்வு ண஦்றுண் தி஝்஝மி஝஧்  

2. தி஝்஝ படிபடண஢்பு  

3. மு஡்-உருபாக்குட஧்  

4. ப஥வு-தசபவு தி஝்஝மி஝஧்  

5. ஢஧்லூ஝கட்டட உருபாக்குண் குழு  

6. ப஡்த஢ாருந் / தண஡்த஢ாருந் டடா஠்்தடடுட்ட஧்  

7. த஢ாருந஝க்கட்டட பட஥தறுட்ட஧்  

8. க஝்஝டண஢்ட஢ டதா஥ ்தசத்ட஧்  

9. உருபாக்குட஧்  

10. டசாதிட்ட஧்  

11. ஆபஞ஢்஢டுட்துட஧்  

12. ஢஧்லூ஝க தி஝்஝ட்டட பனங்குட஧்  

 

2 

அடசவூ஝்஝஧் த௃஝஢்ங்கந் ஢஦்றி வி஥ிபாக விப஥ிக்கவுண்.  

அடசதா ஢஝ங்கடந (Still images) மிக விட஥பாக காஞ்பி஢்஢ட஡் மூ஧ண் 

அப஦்ட஦ தடா஝஥ச்ச்ிதா஡ அடசவு ட஢ா஡்஦ உஞ஥ட்ப தகாடுக்குண் தசதட஧ 

அடசவூ஝்஝஧் ஆகுண். அடசவூ஝்஝லி஧், திட஥த஢ாருந் ஋஡்஢து எரு தபக்஝஥ ்

஢஝ணாகுண். ஋ஞ் ணா஦்஦ட்டட஢் ஢த஡்஢டுட்தி எருங்கிடஞ஢்புகடந (Coordinates) 

பட஥தறுக்க ஢஝ட்து஝஡் அட஡் ஢ாடடம௃஡் இதக்கண் கஞக்கி஝஢்஢டுண். 

குட஦஠்ட஢஝ச் ச஝்஝க விகிடண் (Framerate) 16 ச஝்஝ங்கந் வி஠ாடி ஋஡ இரு஠்டா஧் 

தண஡்டணதா஡ டடா஦்஦ட்டடக் தகாடுக்குண். இத஦்டக டடா஦்஦ட்தி஦்கு 

குட஦஠்ட஢஝ச்ண் வி஠ாடிக்கு 25 ச஝்஝கங்கநாக இரு அ஧்஧து 

மு஢்஢஥ிணாஞங்கடநக் தகாஞ்஝து.  திட஥ம௃஧் X ண஦்றுண் Y 

அசச்ுகளுக்கிட஝டததா஡ ஢஥஢்பி஧் இரு஢஥ிணாஞ அடசவூ஝்஝஧் ஠ின஦்஢஝ட்டட 

உம௃ட஥ா஝்஝ணாக தகாஞ்டு பருகி஦து. மு஢்஢஥ிணாஞ அடசவூ஝்஝ட்தி஧் X, Y 

ண஦்றுண் Z ஆகித மூ஡்று அசச்ுகளுக்கிட஝டத உம௃ட஥ா஝்஝ண் ஠ட஝த஢றுகி஦து. 

இ஥ஞ்டு படகதா஡ அடசவூ஝்஝஧்கநாப஡  
 

஢ாடட அடசவூ஝்஝஧்  

ணா஦ாட பி஡்஡ஞிடதக் தகாஞ்஝ திட஥ம௃஧் எரு த஢ாருடந ஠க஥ட்்துபடட 

உந்ந஝க்கிதது ஢ாடட அடசவூ஝்஝஧் ஆகுண்.  

ச஝்஝க அடசவூ஝஝்஧்  

இ஠்ட அடசவூ஝்டி஧், ஢஧ த஢ாரு஝க்ந் எட஥ சணதட்தி஧் ஠க஥ப்ட஦்கு 

அனுணதிக்கி஦து ண஦்றுண் பி஡்஡ஞி அ஧்஧து த஢ாருந்களுண் ணாறுகி஦து.  
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அடசவூ஝்஝஧் திட஥஢்஢஝துட஦ம௃஧் உந்ந பாத்஢்புகந் ஢஦்றி கஞ்஝றிதவுண்.  

த஢ாழுதுட஢ாக்கு தடாழி஧் துட஦ம௃஧் குறி஢்பி஝ட்டக்க மு஡்ட஡஦்஦ட்தி஦்கு 

஢஧்லூ஝க தடாழி஧்த௃஝்஢ண் முக்கித கா஥ஞணாகுண். இ஠்ட தடாழி஧் த௃஝்஢ணா஡து 

பாத஡ாலி, தடாட஧க்கா஝்சி, ஆ஡்ட஧஡் விடநதா஝ட்ு, டடடப஢்஢டுண் 

எநிக்கா஝்சி ட஢ா஡்஦ அட஡ட்து படகதா஡ த஢ாழுது ட஢ாக்கு அண்சங்கநி஧் 

டடடப஢்஢டுகி஡்஦து. டடடப஢்஢டுண் எநிக்கா஝்சி அ஧்஧து டடடப஢்஢டுண் 

திட஥஢்஢஝ட்டட வீடுகநி஧் உந்ந தடாட஧க்கா஝்சி த஢஝்டிக்கு ட஡ி஢்஢஝்஝ 

முட஦ம௃஧் துபங்குபது எரு டசடபதாகுண். திட஥஢்஢஝ங்கந் டணத 

டசடபதகட்தி஧் டசமிக்க஢்஢஝ட்ு தடா஝஥ப்ு பட஧தடண஢்பி஡் மூ஧ண் 

அனு஢்஢டுகி஡்஦து. தடா஝஥ப்ு பட஧தடண஢்பி஧் இடஞக்க஢்஢஝ட்ுந்ந தச஝்-஝ா஢் 

஢ாக்ஸ் (Set Top Box) ஆ஡து இ஧க்க டகப஧்கடந எ஢்புடண டகப஧்கநாக ணா஦்றி 

தடாட஧க்கா஝்சி த஢஝்டிக்கு உந்நடீு தசத்கி஡்஦து.  

 

4 

஢஧்லூ஝க உருபாக்க குழுவி஡் ஢ஞிகந் ண஦்றுண் த஢ாறு஢்புகந் வி஥ிபாக ஋ழுதுக. 

஢஧்லூ஝க உருபாக்கட்தி஧் அதிக஢஝்ச ஢஧ட஡ உத஥ட்஥ தி஦டணம௅஝஡் த஢றுண் 

படகம௃஧் குழு உறு஢்பி஡஥க்டந டண஧ாஞ்டண தசத்பது க஝்஝ாணாகுண். ஠஧்஧ 

ட஥ணா஡ உத஥஠்்ட ஢஧்லூ஝க உருபாக்க ஢த஡்஢ா஝்டி஦்கு பி஡்பருண் 

உறு஢்பி஡஥க்டநக் தகாஞ்஝ ப஧்லு஠஥ ்குழு டடடப஢்஢டுகி஦து.  

1. டதா஥ி஢்பு டண஧ாந஥ ் 

஢஧்லூ஝க உருபாக்குப஧், குறிட்ட ட஠஥ட்தி஧் முழு ட஥ட்து஝஡் ஢஧்லூ஝க 

தி஝்஝ உருபாக்கட்டட பட஥தறு஢்஢து ண஦்றுண் எருங்கிடஞ஢்஢து 

டதா஥ி஢்பு டண஧ாந஥ி஡் ஢ங்கு ஆகுண்.  

2. த஢ாருந஝க்க ப஧்லு஠஥ ் 

த஢ாருந஝க்க ப஧்லு஠஥ ் ஋஡்஢ப஥ ் ஌஦்க஡டப தி஝்஝மி஝஢்஢஝்஝ 

஢த஡்஢ா஝்டி஡் த஢ாருந஝கட்டட஢் ஢஦்றித அட஡ட்து ஆ஥ாத்சச்ி 

தசத஧்஢ாடுகடநம௅ண் தசத்பட஦்கு த஢ாறு஢்஢ா஡ப஥ ்ஆபா஥.்  

3. ஸ்கி஥ி஢்஝ ்஋ழுடட்ாந஥ ் 

எநிக்கா஝்சி ண஦்றுண் ஢஝சச்ுருந் ஸ்கி஥ி஢்஝க்ந் தடா஝஥ச்ச்ிதா஡ 

ப஥ிடசம௃லுந்ந ஠ிகன்வுகடநக் குறிக்குண். ஸ்கி஥ி஢்஝் ஋ழுட்டாந஥ ்

கருட்துருக்கடந மு஢்஢஥ிணா஡ சூன஧்கநி஧் கா஝்சி஢்஢டுட்துகி஦ா஥.்  

4. உட஥ ஢தி஢்஢ாந஥ ்(Text Editor)  

஢஧்லூ஝க உருபாக்குபதி஡் த஢ாருந஝க்கண் ஋஢்த஢ாழுதுண் டருக்க 

஥ீதிதா஡ ஏ஝்஝ணாக இருட்ட஧் டபஞ்டுண்.  

5. ஢஧்லூ஝க படிபடண஢்஢ாந஥ ் 

஢஧்லூ஝க படிபடண஢்஢ாந஥ ் ஢஧்லூ஝கட்தி஡் அட஡ட்து அடி஢்஢ட஝ட் 

தடாகுதிகநா஡ பட஥கட஧, உட஥, எலி, இடச,  எநிக்கா஝்சி, 

புடக஢்஢஝ண் ண஦்றுண் ஢ட஝஢்஢ாக்க தண஡்த஢ாருடந஢் ஢த஡்஢டுட்தி 

அடசவூ஝்஝஧் ட஢ா஡்஦ப஦்ட஦ எருங்கிடஞ஢்஢ா஥ ்.  

6. கஞி஡ி பட஥கட஧ கட஧ஜ஥ ் 

஠ி஥லி஡் பட஥கட஧ கூறுகநா஡ பி஡்஡ஞி, பு஧்஧஝க்ந், த஢ாட்டா஡்கந், 

஢ா஝஢்஢தி஢்஢ாத்வு,  3-D த஢ாருந்கந், அடசவூ஝்஝஧் ண஦்றுண் சி஡்஡ங்கந் 

ஆகிதப஦்ட஦க் டகதாளுண் ஢ங்கிட஡ கஞி஡ி பட஥கட஧ கட஧ஜ஥ ்

பகிக்கி஦ா஥.்  

7. எலி ண஦்றுண் எநிக்கா஝ச்ி ப஧்லு஠஥ ் 

஋டுட்துட஥ட்ட஧் ண஦்றுண் டசமிக்க஢்஢஝்஝ எநிக்கா஝்சிகடந஢் ஢஧்லூ஝க 

஠ிகன்ட்துடலி஧் டகதாநட் டடடப஢்஢டு஢பட஥ எலி ண஦்றுண் எநிக்கா஝்சி 

ப஧்லு஠஥ ்ஆபா஥.்  

8. கஞி஡ி ஠ி஥஧ா ் 

கஞி஡ி ஠ி஥஧ா ்த஢ாருட்டணா஡ தணாழிம௃஧் குறிமுட஦ அ஧்஧து ஸ்கி஥ி஢்஝் 

ப஥ிகடந ஋ழுதுகி஦ா஥.் இ஠்ட ஸ்கி஥ி஢்஝க்ந் பனக்கணாக சி஦஢்பு 

தசத஧்஢ாடுகடந உருபாக்குண்.  

9. பட஧ ப஧்லு஠஥ ் 

எரு இடஞத பட஧஢்஢க்கட்டட உருபாக்கி அடட ஢஥ாண஥ி஢்஢து பட஧ 

ப஧்லு஠஥ி஡் த஢ாறு஢்஢ாகுண் 
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஢஧்லூ஝க டகா஢்பி஧் உந்ந தபப்டபறு டகா஢்பு படிபங்கடந விப஥ிக்கவுண்.  

உட஥ படிபங்கந்  

1. RTF(Rich Text Format) டணக்ட஥ாசா஢்஝் ஠ிறுப஡ட்டா஧் 1987 ஆண் ஆஞ்டு 

பி஥சு஥ிக்க஢்஢஝்஝ டதா஥ி஢்புகநி஡் குறி஢்புகந் ண஦றுண் குறுக்கு ஢ஞிட்டந 

ஆபஞங்கநி஡் ஢஥ிணா஦்஦ங்கடநாடு அறிமுக஢்஢டுட்ட஢்஢஝்஝து.  

2. Plain Text டகா஢்புகடந ஢஧ உட஥ ஢தி஢்஢ா஡்கநி஧் தி஦க்க஧ாண், 

஢டிக்க஧ாண் ண஦்றுண் ஢தி஢்஢ாத்வு தசத்த஧ாண். 

஠ின஦்஢஝ படிபங்கந்  

1. TIFF (Tagged Image File Format)  இ஠்ட படிபண் கஞி஢்த஢ாறி ஢தி஢்஢க உ஧கி஧் 

த஢ாதுபா஡து ஆகுண். இது த஢ாதுபாக அட஡ட்து தண஡்த஢ாருந் 

தடாகு஢்புகடந ஆட஥ிக்கி஦து. 

2. BMP (Bitmap) இது தடா஝க்கட்தி஧் விஞ்ட஝ாஸ் 3.1-஧் ஢த஡்஢டுட்ட஢்஢஝்஝து. 

இது மிகவுண் த஢஥ிதது ண஦்றுண் குறுக்கண஦்஦து ஋஡டப, இது அதிக 

தடநிவுட்தி஦஡் அ஧்஧து த஢஥ித ஠ின஦்஢஝ங்களுக்காக 

஢த஡்஢டுட்ட஢்஢டுகி஦து. 

3. DIB (Device IndependentBitmap) இ஠்ட படிபண் BMP-டத எட்டடாகுண். இது 

டகா஢்புகடந ஢஧்டபறு சாட஡ங்கநி஧் காஞ்பிக்க அனுணதிக்க஦து. 

4. GIF (Graphics Interchange Format) ஋஡்஢து குறுக்க஢்஢஝்஝ ஠ின஦்஢஝ 

படிபணாகுண்.த஢ருண்஢ா஧ா஡ கஞி஡ி பஞ்ஞ ஠ின஦்஢஝ங்கந் ண஦்றுண் 

பி஡்஡஡ிகந் GIF டகா஢்புகநாகுண். 

5. JPEG (Joint Photographic Experts Group) அதிக஢஝்ச ஠ின஦்஢஝ குறுக்கட்டட 

அட஝பட஦்காக படிபடணக்க஢்஢஝ட்ுந்நது. இது புடக஢்஢஝ண், இத஦்டக 

கட஧டபட஧஢்஢ாடு ண஦்றுண் அடட஢்ட஢ா஡்஦ த஢ாருந்களு஝஡் ஠஡்஦ாக 

டபட஧ தசத்ம௅ண். ஆ஡ா஧் ஋ழுட்துமுட஦, உம௃ட஥ா஝்஝ணா஡ பட஥ட஧் 

அ஧்஧து ஋நித டகலிசச்ிட்தி஥ங்கநி஧் குட஦஠்ட அநவி஧் தசத஧்஢டுண். 

6. TGA (Tagra) இது அதிக தடநிவுட்தி஦஡் ஠ின஦்஢஝ங்களுக்கா஡ முட஧் 

பி஥஢஧ணா஡ படிபணாகுண். த஢ருண்஢ா஡்டணதா஡ எநிக்கா஝்சி பிடி஢்பு 

஢஧டககந் TGA-டப ஆட஥ிக்கி஡்஦஡. 

7. PNG (Portable Network Graphics) இது குட஦஠்ட இன஢்பு, சிறிதது ண஦்றுண் ஠஡்கு 

குறுக்க஢்஢஝ட்ு தசப்பக ஠ின஦்஢஝ங்கநாக டசமிக்க஢்஢டுண் எரு ஠ீ஝்டி஢்பு 

டகா஢்பு படிபணாகுண். இது GIF-க்கு ணா஦்஦ாக தசத஧்஢டுகி஦து. ண஦்றுண் 

TIFF-஡் ஢஧ த஢ாதுபா஡ ஢த஡்கடநம௅ண் ணா஦்றுகி஦து. 

இ஧க்க எலி டகா஢்பு படிபங்கந்  

1. WAV (Waveform Audio File Format)     இது விஞ்ட஝ாஸி஧் குறுக்க஢்஢஝ாட எலி 

டகா஢்புகடநச ்டசமிக்குண் மிகவுண் பி஥஢஧ணா஡ எலி டகா஢்பு 

படிபணாகுண். 

2. MP3 (MPEG layer-3 Format)    இடசடத டசமிக்கவுண் ஢திவி஦க்கண் 

தசத்தவுண் மிகவுண் பி஥஢஧ணா஡ படிபண் MPEG Layer-3 படிபணாகுண். 

3. OGG  சி஦஠்ட ஏ஝்஝ட்திட஡ அட஝பட஦்காக படிபடணக்க஢்஢஝்஝ இ஧பச 

தி஦஠்ட மூ஧ தகாந்க஧஡் (Container) படிபணாகுண். 

4. AIFF (Audio Interchange File Format) Mac ஢த஡்஢டுட்துண் WAV டகா஢்புகடந஢் 

ட஢ா஧் Apple  ஠ிறுப஡ண் ஢த஡்஢டுட்துண் ட஥ணா஡ எலி படிபண் இது ஆகுண். 

5. WMA (Windows Media Audio) மிகவுண் பி஥஢஧ணா஡ WMA படிபட்தி஡் 

உ஥ிடணதாநா ்டணக்ட஥ா சா஢்஝் ஆகுண். ஢தி஢்பு஥ிடண (Copy right) 

஢ாதுகா஢்பி஦்காக DRM (Digital Right Management) தி஦஡்கடநாடு 

படிபடணக்க஢்஢஝ட்ுந்நது.   

6. RA (Real Audio Format) படிபண் இடஞதட்தி஧் எலிம௃஡் ஏ஝்஝ட்தி஦்காக 

படிபடணக்க஢்஢஝்஝டாகுண். இ஧க்க எலி பநங்கடந஢் த஢ாதுபாக 

கஞி஡ிக் டகா஢்புகநாக கஞி஡ிம௃஡் ப஡்ப஝ட்ு அ஧்஧து CD / DVD-கநி஧் 

டசமிக்க஢்஢டுகி஦து. 

இ஧க்க எநிக்கா஝ச்ி டகா஢்பு படிபங்கந்  

1. AVI(Audio/Video Interleave) இது எரு விஞ்ட஝ாஸி஦்கா஡ எரு எநிக்கா஝்சி 

டகா஢்பு படிபணாகுண். இங்கு, எலி ண஦்றுண் ஢஝ட்தி஡் கூறுகடநக் 

டகா஢்பி஧் ணா஦்று த஠டுப஥ிடச தடாகு஢்பி஧் (interleave chunk) 

டசமிக்க஢்஢டுகி஦து. 

2. MPEG(Moving Picture Experts Group)  ஋஡்஢து இ஧க்க எநிக்கா஝்சி ண஦்றுண் எலி 

குறுக்கட்டட ISO (International Standards Organization) குழுவி஡஥ா஧் 

உருபாக்க஢்஢டுண் எரு ட஥஠ிட஧ ஆகுண். 
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஢ா஝ண் 5 

அட஝ா஢் ஃ஢்நாஷ் ஢்த஥ா஢்஢ஷ஡஧் CS6 

஢குதி – அ 

I. ச஥ிதா஡ விட஝டதட ்டடா஠்்தடடுடத்ு ஋ழுதுக  

1 
Adobe Flash ஠ி஥஧் மூ஧ண் ஠ீங்கந் ஋டட஡ உருபாக்க முடிம௅ண்?  ஈ) டணட஧ உந்ந 

அட஡டத்ுண் 
 

2 
Flash ஢ஞிம௃஝ டணதட்தி஡் ஠டுவி஧் உந்ந த஢஥ித தபந்டந தசப்பக படிபண் ---

--------   அ) டணட஝ 
 

3 எரு புதித Flash ஆபஞட்டட ஋ப்பாறு உருபாக்குபாத் ? இ) File → New  

4 
தகா஝ா஠ிட஧ ஢ஞிட்டநட்தி஡் ஠ி஦ண் தபந்டந.  இடட ணா஦்஦ --------- 

டடா஠்்தடடுக்கவுண். ஆ) Modify  → Document 
 

5 Flash டகா஢்புகந் --------- ஋஡வுண் அடனக்க஢்஢டுகி஦து. ஆ) Flash Movies  

6 
கப஡ட்டட ஈ஥க்்குண் படகம௃஧ா஡ ஢டாடககடந (Banner) --------- மூ஧ண் 

உருபாக்க஧ாண். இ) Flash 
 

7 Flash டகா஢்பி஡் தகா஝ா஠ிட஧ வி஥ிபாக்கண் -------- ஈ) .fla  

8 
Flash-஧் ஠ீங்கந் உருபாக்குண் ஋஠்ட உந்ந஝க்கணாம௃னுண் அது -------  ஋஡்று 

அடனக்க஢்஢டுகி஦து. ஈ) ஢த஡்஢ாடு 
 

9 
஠ீங்கந் து஥ிடகடத ஢த஡்஢டுட்தி பட஥பது ட஢ா஡்று டகாடுகடந பட஥த 

உடவுண் கருவி அ) Brush Tool 
 

10 
கீன்கஞ்஝ ஋஠்ட கருவி, கருவி஢் ஢஧கட்தி஧் எட஥ குழுவி஧் இ஝ண்த஢஦வி஧்ட஧. இ) 

Line Tool 
 

11 
Oval கருவிடத ஢த஡்஢டுட்தி ஋ப்பாறு எரு ப஝்஝ட்டட பட஥த஧ாண்? ஈ) Shift 

விடசடத அழுடத்ி டபடத்ுக் தகாஞ்ட஝. 
 

12 
஋஠்ட கருவி எரு பட஥஢஝ட்தி஡் குறி஢்பி஝்஝ ஢குதிடத த஢஥ிடாக்கி கா஝ட்ுண்.  இ) 

The Zoom tool 
 

 

II டகாடி஝஝் இ஝ங்கடந ஠ி஥஢்புக 

1 
஢ஞிட்டநட்தி஧் --------- கருவிடத ஢த஡்஢டுட்தி எரு ட஠ாட்கா஝ட்஝ 

பட஥த஧ாண். (Line Tool ட஧஡் கருவி) 
 

2 
எரு ப஝்஝ண் பட஥த Oval கருவிடத கிநிக் தசத்து ----------- விடசடத அழுட்தி 

தகாஞ்ட஝ ஠க஥ட்்ட டபஞ்டுண். (Shift) 
 

3 ஠ீங்கந் -------------- கருவி மூ஧ண் சது஥ண் பட஥த முடிம௅ண். (Rectangle)  

4 
சாடா஥஡ அழி஢்஢ா஡் ட஢ா஡்று த஢ாரு஝க்டந அழி஢்஢ட஦்கு ---------- உடவுகி஦து 

(Eraser) 
 

5 Flash டகா஢்புகந் டா஡ாகடப ------------ வி஥ிவு஝஡் உருபாகுண். (.fla)  

 

஢குதி – ஆ 

II. மூ஡்று ப஥ிகநி஧் விட஝தநிக்கவுண். 

1 

Flash ஋஡்஢து ஋஡்஡?  

Adobe Flash Professional CS6 அ஡ிடணஷ஡்கடந உருபாக்க ஢த஡்஢டுண் 

தண஡்த஢ாருந். அடி஢்஢ட஝ த஢ாரு஝க்டந பட஥தவுண் கா஝்சிகடந 

உருபாக்கவுண் ஢த஡்஢டுட்டக்கூடித கருவிகந் உந்ந஡ . இது (Adobe) அட஝ா஢் 

஠ிறுப஡ட்டா஧் உருபாக்க஢்஢஝ட்ுந்நது.  

 

2 

Adobe ProfessionalFlash CS6஍ தடா஝ங்க டடடபதா஡ ஢டி஠ிட஧கடந ஋ழுதுக.  

அட஝ா஢் ஃ஢்நாஷ் ஢்த஥ா஢்஢ஷ஡஧் CS6 டத தடா஝ங்க start → All programs → 

Adobe Flash professional CS6 – டத டட஥வ்ு தசத்தவுண்.  

1. ஃ஢்நாஷ்-஧் ஠ீங்கந் பட஥பட஦்கு (அ) அடசவூ஝்஝ண் தசத்பட஦்கு மு஡்பு 

முடலி஧் ஠ீங்கந் எரு புதித ஆபஞட்டட உருபாக்க டபஞ்டுண்.  

ப஥டப஦்பு திட஥ம௃லிரு஠்டடா (welcome screen) (அ) திட஥ம௃஡் 

டண஦்஢குதிம௃஧் உந்ந File ஢஝்டிம௃லிரு஠்டடா எரு புதித ஆபஞட்டட 

உருபாக்க முடிம௅ண்.  

2. எரு புதித ஆபஞட்டட File ஢஝்டிம௃லிரு஠்து உருபாக்க file → New–டத 

டட஥஠்்தடடுட்டா஧் New Document உட஥தா஝஧் த஢஝்டி டடா஡்றுண். அதி஧் 

 

www.Padasalai.Net                                                                   www.CBSEtips.in

Kindly send me your answer keys to our email id - padasalai.net@gmail.com



Padasalai.Net

 25 ,uh.ghh;j;jPgd;>M.Sc.,M.Ed.,M.Phil., fzpdp gapw;Weh;> muR Mz;fs; Nky;epiyg;gs;sp - ghg;gpnul;bg;gl;b 

 

General டட்டலி஡் கீன் உந்ந ActionScript 3.0 –டத டட஥஠்்தடடுட்து OK  

த஢ாட்டாடந கிநிக் தசத்டா஧் எரு புதித ஆபஞண் உருபாகுண்.  

3 

கா஧க்டகா஝ட்ி஡் (Time line) ஡் டடடப ஋஡்஡?  

(Timeline) கா஧க்டகாடு ஋஡்஢து Flash-஡் மிக முக்கிதணா஡ கூறுகநி஧் எ஡்஦ாகுண். 

இது டணட஝க்கு கீடன அடண஠்துந்நது. இது எப்தபாரு உறு஢்பு டடா஦்஦ட்டடம௅ண் 

அ஡ிடணஷட஡ம௅ண் குறிக்க ஢த஡்஢டுட்ட஢்஢டுகி஦து. 

 

 

஢குதி – இ 

III. எரு ஢டத்ிதநவி஧் விட஝தநிக்கவுண். 

1 

கீன்கஞ்஝ தசத஧்கடந தசத்த உடவுண் கருவிகடந கூறுக.  

அ. டகாடு பட஥ட஧்  

Line கருவி (N)  

இது ட஠஥ட்காடுகடந பட஥பட஦்கு஢் ஢த஡்஢டுகி஦து. ஠ீங்கந் தசங்குட்து, 

கிட஝ண஝்஝ ண஦்றுண் 450 மூட஧வி஝்஝ டகாடுகடந பட஥பட஦்கு Shift 

விடசடத அழுட்தி஢்பிடிக்க டபஞ்டுண்.  

ஆ. ட஦்க஢ாக்கு உருபண் படநட஧்  

Pencil கருவி  இது ட஦்ட஢ாக்காக (freehand) டகாடுகந் ண஦்றுண் படிபங்கடந 

பட஥த஢் ஢த஡்஢டுகி஦து. த஢஡்சி஧் முட஦ (Mode) விரு஢்஢ட்தி஧் உந்ந 

஢஝்டி பி஡்பருண் க஝்஝டநகடந கா஝ட்ுண்.  

 Straighten -ட஠஥க்்டகா஝்டிட஡ பட஥பட஦்கு,  

 Smooth – பட஧ டகா஝்டிட஡ பட஥பட஦்கு  

 Ink - அநவுடகா஧஦்஦ பட஥஢஝ங்கநந ஋஠்ட ணா஦்஦முண் இ஡்றி 

பட஥த  

இ. ஠ீங்கந் பட஥஠்டப஦்ட஦ அழிடட்஧்  

Eraser கருவி (E)  இது டகாடுகந் ண஦்றுண் உ஝்஢஥஢்புகடந (Fill) அழிக்க஢் 

஢த஡்஢டுகி஦து  

 

2 

Zoom கருவி ண஦்றுண் Hand கருவி டபறு஢ாடுகடநக் கூறுக.  

Zoom கருவி (Z)  

இது டணட஝஢்஢குதிடத த஢஥ிடாக ணா஦்஦஢் ஢த஡்஢டுகி஦து. இது டண஝ம௃஧் 

எரு ஢குதிம௃஧் கிநிக் தசத்பட஡் மூ஧ண் அடட஡ த஢஥ிடாக்க஧ாண். Alt 

விடசடத அழுட்தி஢்பிடிட்து டணட஝ம௃஧் கிநிக் தசத்டா஧் அடட஡ 

சிறிடாக்க஧ாண்.  

Hand கருவி (H)  

இது டணட஝டத ஠க஥ட்்ட ஢த஡்஢டுகி஦து. எ஝ட்ு ஢஧டகம௃஧் ஋ங்கு 

டபஞ்டுணா஡ாலுண் ஢ஞிட்டநட்டட இழுட்து ஠க஥ட்்ட஧ாண்.  

 

 

஢குதி – ஈ 

IV. எரு ஢க்க அநவி஧் விட஝தநிக்கவுண் 

1 

Flash ச஡்஡஧் திட஥ம௃஧் ஢த஡்஢டுடத்ுண் கூறுகடந விப஥ி.  

ஃ஢்தநாஷ் ச஡்஡஧் திட஥ கூறுகந் (அ) ஢குதிகந்  

ஃ஢்நாஷ் ச஡்஡஧் திட஥ ஠ா஡்கு ஢குதிகநாக (அ) கூறுகநாக 

பி஥ிக்க஢்஢஝ட்ுந்நது. அடப  

1. ஢ஞிட்டநண் ண஦்றுண் எ஝ட்ு஢்஢஧டக (Stage and paste Board)  

2. கா஧க்டகாடு (Timeline)  

3. கருவிகந் ஢஧கண் (Tools Panel)  

4. ஢ஞ்பு டசாதி஢்஢ா஡் (Property Inspector)  

஢ஞிடட்நண் ண஦்றுண் எ஝ட்ு஢்஢஧டக (஢ஞி஢்஢குதி) (The Stage and Pasteboard 

(work area)  

உங்கந் ஢ஞிட்டநட்தி஡் ஠டுவி஧் உந்ந தசப்பக தபந்டந஢்஢குதி 

டணட஝ (Stage) ஋஡ அடனக்க஢்஢டுகி஦து. அடசவு஢் ஢஝ட்தி஦்கா஡ 

அடசவூ஝்஝ங்கந், த஢ாரு஝்கந் ண஦்றுண் கா஝்சிகந் ஆகிதப஦்ட஦ 

உருபாக்க, ஢தி஢்பிக்க இருட்திடபக்க ண஦்றுண் இதக்க இ஠்ட டணட஝ 

உடவுகி஦து.  

கா஧க்டகாடு (Time Line)  

கா஧க்டகாடு ஋஡்஢து ஃ஢்நாஷ்-஡் மிக முக்கிதணா஡ கூறுகநி஧் 

எ஡்஦ாகுண். இது ஢ஞிட்டந஢் ஢குதிம௃஡் கீடன அடண஠்துந்நது. இது 
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எப்தபாரு உறு஢்பி஡் டடா஦்஦ட்டடம௅ண் ண஦்றுண் அடசவூ஝்஝ட்டடம௅ண் 

தடநிபாக கா஝்஝ ஢த஡்஢டுகி஦து.  

ஃ஢்தநாஷ் கருவிகந் ஢஧கண் (The Flash Tools Panel)  

ஃ஢்நாஷ் கருவிகந் ஢஧கண் ஠ீங்கந் டணட஝ம௃஧் பட஥கட஧டத 

உருபாக்க, டட஥஠்்தடடுக்க (அ) ஢தி஢்பிக்கட் டடடபதா஡ கருவிகடந 

தகாஞ்டுந்நது.  

஢ஞ்பு டசாதி஢்஢ா஡் (Property inspector)  

இது தகா஝ா஠ிட஧தாக Flash ஢ஞிம௃஝ட்தி஡் ப஧து ஢க்கட்தி஧் டடா஡்றுண். 

இது த௄஧க஢்஢஧கட்து஝஡் இடஞக்க஢்஢஝்டிருக்குண். இது 

டட஥஠்்தடடுக்க஢்஢஝்஝ த஢ாருநி஡் ஢ஞ்புகந் ண஦்றுண் விரு஢்஢ங்கடநக் 

கா஝ட்ுபடடாடு அப஦்ட஦ ணா஦்஦வுண் அனுணதிக்கி஦து.  

2 

Tools ஢஧கடத்ி஧் காஞ஢்஢டுண் கருவிகந் சி஧ப஦்ட஦ விப஥ி.  

Selection கருவி (V)  

இ஠்ட கருவி எரு த஢ாருந் (அ) எரு த஢ாருநி஡் ஢குதிதாகித தபநிக்டகாடு 

ண஦்றுண் உ஝்஢஥஢்பு (Stroke & Fill) ஆகிதப஦்ட஦ட் டட஥஠்்தடடுக்க 

஢த஡்஢டுகி஦து.  

Free Transform கருவி (Q)  

இது த஢ாருந்கடந சுன஦்஦, அநவி஝, படநக்க ண஦்றுண் உருக்குட஧க்க 

஢த஡்஢டுகி஦து.  

3D Rotation கருவி (W)  

இது டணட஝ம௃஧் மு஢்஢஥ிணாஞ தபநிம௃஧் ச஧஡஢்஢஝ட் துஞ்டுகுகடந 

(Movie Clips) சுன஦்றுபட஡் மூ஧ண் மு஢்஢஥ிணாஞ விடநவுகடந உருபாக்க 

஢த஡்஢டுகி஦து.  

Lasso கருவி (L)  

சாடா஥ஞணாக எரு த஢ாருடநச ் சு஦்றிபட஥பட஡் (Freehand) மூ஧ண், இது 

த஢ாருந்கடந டட஥஠்்தடடு஢்஢ட஦்கு (அ) த஢ாருநி஡் எரு ஢குதிடத 

டட஥஠்்தடடு஢்஢ட஦்கு ஢த஡்஢டுகி஦து.  

Pen கருவி (P)  

இது ஠ங்கூ஥஢் புந்நிகந் ஋஡஢்஢டுண்.  தடா஝஥ப்ுந்நிகடந 

உருபாக்குபட஡் மூ஧ண்டகாடுகந் ண஦்றுண் பட஥டகாடுகடந 

பட஥பட஦்கு ஢த஡்஢டுகி஦து.  

Text கருவி (T)  

இது உட஥டத உருபாக்க ண஦்றுண் ஢தி஢்பிக்க ஢த஡்஢டுகி஦து.  

Line கருவி (N)   

இது ட஠஥ட்காடுகடந பட஥பட஦்கு஢் ஢த஡்஢டுகி஦து. ஠ீங்கந் தசங்குட்து, 

கிட஝ண஝்஝ ண஦்றுண் 450 மூட஧வி஝்஝ டகாடுகடந பட஥பட஦்கு Shift 

விடசடத அழுட்தி஢்பிடிக்க டபஞ்டுண்.  

Rectangle கருவி (R)  

இது தசப்பகண் பட஥த஢் ஢த஡்஢டுகி஦து. Shift அழுட்தி஢் பிடி஢்஢ட஡் 

மூ஧ண் சது஥ண் பட஥த஧ாண்.  

3D Translation கருவி (G)  

இது டணட஝ம௃஧் மு஢்஢஥ிணாஞ தபநிம௃஧் ச஧஡஢்஢஝ட் துஞ்டுகடந 

(Movie Clips) ஠க஥ட்்துபட஡் மூ஧ண் மு஢்஢஥ிணாஞ விட஥வுகடந 

உருபாக்க஢் ஢த஡்஢டுகி஦து.  

Oval கருவி (O)  

இது ஠ீந்ப஝்஝ படிபங்கடந பட஥பட஦்கு ஢த஡்஢டுகி஦து. ச஥ிதா஡ 

ப஝்஝ட்டட பட஥பட஦்கு Shift விடசடத அழுட்தி஢்பிடிக்க டபஞ்டுண்.  

Poly Star கருவி  

இது ஢஧டகாஞண் ண஦்றுண் ஠஝ச்ட்தி஥ங்கடந பட஥த ஢த஡்஢டுகி஦து. 

தசப்பகண், ஠ீந்ப஝்஝ண், பி஥ிமி஝்டிப் தசப்பகண் ண஦்றுண் Poly Star கருவிகந் 

஋஧்஧ாண் எட஥ கருவிம௃஧் தடாகுக்க஢்஢஝ட்ு கருவி ஢஧கட்தி஧் உந்நது.  

Pencil கருவி  

இது ட஦்ட஢ாக்காக (freehand) டகாடுகந் ண஦்றுண் படிபங்கடந பட஥த஢் 

஢த஡்஢டுகி஦து.  

Brush கருவி (B)  

இது தூ஥ிடககந் ட஢ா஡்஦ டகாடுகந் (Paint) பட஥பட஦்கு ஢த஡்஢டுகி஦து.  

Eraser கருவி (E)  

இது டகாடுகந் ண஦்றுண் உ஝்஢஥஢்புகடந (Fill) அழிக்க஢் ஢த஡்஢டுகி஦து.  
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Hand கருவி (H)  

இது டணட஝டத ஠க஥ட்்ட ஢த஡்஢டுகி஦து. எ஝ட்ு஢஧டகம௃஧் ஋ங்கு 

டபஞ்டுணா஡ாலுண் ஢ஞிட்டநட்டட இழுட்து ஠க஥ட்்ட஧ாண்.  

Zoom கருவி (Z)  

இது டணட஝ ஢குதிடத த஢஥ிடாக ணா஦்஦஢் ஢த஡்஢டுகி஦து. இது 

டணட஝ம௃஧் எரு ஢குதிம௃஧் கிநிக் தசத்பட஡் மூ஧ண் அடட஡ 

த஢஥ிடாக்க஧ாண். Alt விடசடத அழுட்தி஢்பிடிட்து டணட஝ம௃஧் கிநிக் 

தசத்டா஧் அடட஡ சிறிடாக்க஧ாண்.  

Stroke Color கருவி  

இது பட஥த஢்஢஝்஝ த஢ாருந்கநி஡் தபநிக்டகா஝்டி஡் ஠ி஦ட்டட ணா஦்றி 

அடணக்க஢் ஢த஡்஢டுகி஦து.  

Fill Color கருவி  

இது பட஥த஢்஢஝்஝ த஢ாருந்கநி஡் உ஝்஢஥஢்பி஡் பஞ்ஞட்டட ணா஦்஦஢் 
஢த஡்஢டுகி஦து. 
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஢ா஝ண் 6 

ஆ஝ட்஝ாடக஝ ்2016 

஢குதி – அ 

I ச஥ிதா஡ விட஝டதட ்டடா஠்்தடடுடத்ு ஋ழுதுக 

1 
ஆ஝்ட஝ாடக஝் ஋஡்஢து _________தண஡்ண஢ாருநாகுண்.  ஆ) Computer-aided design (CAD) 

and drafting 
 

2 
ஆ஝்ட஝ாடக஝் 2016-஍ உருபாக்கி வி஦்஢ட஡ தசத்ம௅ண் ஠ிறுப஡ண் ________ இ) 

Autodesk, Inc. 
 

3 
சிப஢்பு ஠ி஦ ‚A‛ த஢ாட்டாட஡க் கிநிக் தசத்டா஧் டடா஡்றுண் ஢஝்டி_________  அ) 

Application 
 

4 ஢த஡்஢ா஝ட்ு஢் ஢஝்டிம௃஡் டண஧் ஢குதிம௃஧் டடா஡்றுண் ஢஝ட்஝ ஋து? ஆ) Search  

5 
க஝்஝நநச ்சாந஥ண் டடா஡்஦வி஧்ட஧தத஡ி஧் ஋஠்ட விடச஢்஢஧டக 

குறுக்குவிடசகடந஢் ஢த஡்஢டுட்ட டபஞ்டுண்? ஆ) Ctrl + 9 
 

6 UCS ஋஡்஢து ஋ட஡் குறுக்கண்? அ) User Coordinate System  

7 
க஝்஝ங்கடந (grid) காஞ்பிக்கவுண், ணட஦க்கவுண் (ON or OFF) விடச஢்஢஧டகம௃஧் 

஋஠்ட தசத஧்஢ா஝ட்ு விடசடத அழுட்ட டபஞ்டுண்? ஈ) F7 
 

 

஢குதி – ஆ 

II. மூ஡்று ப஥ிகநி஧் விட஝தநிக்கவுண். 

1 

ஆ஝ட்஝ாடகட஝ ஋ப்தபாறு தடா஝ங்குபாத்?  

ஆ஝க்஝ாடக஝் 2016-஍ தடா஝ங்க,  திட஥முக஢்பி஧் உந்ந Auto CAD 2016 –English 

஢ஞிக்குறிடத இருமுட஦ கிநிக் தசத்த டபஞ்டுண்.  

(அ஧்஧து) Start → All Programs → Autodesk → AutoCAD 2016 → AutoCAD 2016 – English 

஋஡்஦ ப஥ிடசம௃஧் கிநிக் தசத்த டபஞ்டுண். 

 

2 

஥ி஢்஢஡ி஧் உந்ந அந஡டத்ு஢் த஢ாடட்ா஡்கடநம௅ண் ஋஢்஢டி ணட஦஢்஢ாத்?  

1. முட஧் முட஦தாக சிறிடாக்கு஢் த஢ாட்டாட஡ கிநிக் தசத்ம௅ண் ட஢ாது 

஥ி஢்஢஡் தடாகுதிகந் ண஦்றுண் ட஢஡஧் த஢ாட்டா஡்களு஝஡் 

கா஝்சிதநிக்குண். 

2. இ஥ஞ்஝ாபது முந஦தாக சிறிடாக்கு஢் த஢ாட்டாட஡ கிநிக் தசத்ம௅ண் 

ட஢ாது, ட஢஡஧் த஢ாட்டா஡்கந் ட஢஡஧் டட஧஢்புகநாக ணாறுண்.  

 

3 

஥ி஢்஢஡ி஧் உந்ந எரு த஢ாடட்ா஡் மீது சு஝ட்ுக்குறிடத ஠ிறுடத்ுண் ட஢ாது ஋஡்஡ 

டடா஡்றுண்?  

முட஧் முட஦தாக சிறிடாக்கு஢் த஢ாட்டாட஡ கிநிக் தசத்ம௅ண் ட஢ாது ஥ி஢்஢஡் 

தடாகுதிகந் ண஦்றுண் ட஢஡஧் த஢ாட்டா஡்களு஝஡் கா஝்சிதநிக்குண். இ஢்த஢ாழுது 

ட஢஡஧் த஢ாட்டா஡ி஡் மீது சு஝்டிடத ஠க஥ட்்தி஡ா஧், அ஠்ட ட஢஡லி஧் உந்ந 

அந஡ட்துக் கருவிகளுண் தட஥ிம௅ண்.  

 

4 

UCS ஢ஞிக்குறிடத ஋ப்பாறு ஠ீக்குபாத்?  

இரு஢஥ிணாஞ பட஥஢஝ங்களுக்கு UCS ஢ஞிக்குறி டடடப஢்஢டுபதி஧்ட஧. 

அ஢்த஢ாழுது UCSICON க஝்஝டந மூ஧ண் அநட ஠ீக்கிவி஝஧ாண்.  

Command : ucsicon  

Enter an option : off 

 

5 

OSNAP-஍ ON ண஦்றுண் OFF தசத்பட஦்கு ஋஠்ட தசத஧்஢ா஝ட்ு விடசடத஢் 

஢த஡்஢டுடட் டபஞ்டுண்?  

F3 தசத஧்஢ா஝ட்ு விடசடத஢் ஢த஡்஢டுட்தி OSNAP-஍ ON ண஦்றுண் OFF 

தசத்த஧ாண். 

 

6 

ட஧஡் (LINE) க஝஝்டநடத஢் ஢த஡்஢டுடத்ுண்ட஢ாது ஢஧ டகாஞடட்ட முடிக்க஢் 

஢த஡்஢டுண் விட஥பா஡ பழிமுட஦டதக் கூறு.  

இ஥ஞ்டு அ஧்஧து அட஦்கு டண஦்஢஝்஝ தடா஝஥ச்ச்ிதா஡ டகாடுகடந பட஥ம௅ண் 

ட஢ாது, Close விரு஢்஢ணா஡து முட஧் டகா஝்டி஡் தடா஝க்க஢் புந்நிடதம௅ண், கட஝சி 

டகா஝்டி஡் முடிவு஢் புந்நிடதம௅ண் இடஞக்க஢் ஢த஡்஢டுகி஦து. 

 

7 

ட஧஡் க஝஝்டந ண஦்றுண் த஥க்஝ாங்க஧் க஝஝்டநடத஢் ஢த஡்஢டுடத்ி தசப்பகண் 

பட஥ம௅ண்ட஢ாது ஌஦்஢டுண் ஠ட஝முட஦ சிக்க஧்கடநக் கூறு. ஌஡் எ஡்ட஦ வி஝ட்ு 

ண஦்த஦ா஡்ட஦஢் ஢த஡்஢டுடட் டபஞ்டுண்?  

ட஧஡் க஝்஝டநடத஢் ஢த஡்஢டுட்திம௅ண் தசப்பகண் பட஥த முடிம௅ண். ஆ஡ா஧் 

அதி஧் சி஧ குட஦஢ாடுகந் உந்ந஡. ஋டுட்துக்கா஝்஝ாக, டகாஞ அநவுகந் 90 
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டிகி஥ி உந்ந஡பா ஋஡ ச஥ி஢ா஥க்்க டபஞ்டுண். டணலுண் எப்தபாரு டகாடுண் 

ட஡ிட்ட஡ி த஢ாருநாக இருக்குண். எரு டகா஝்டி஡் மீது கிநிக் தசத்டா஧் 

அ஠்டடகாடு ண஝ட்ுடண டட஥வ்ு தசத்த஢்஢டுண். ண஦்஦ டகாடுகந் டட஥வ்ு 

தசத்த஢்஢஝ாது. ஆடகதா஧் ஆ஝்ட஝டக஝் 2016இ஧் உந்ந RECTANG க஝்஝டந, 

ச஥ிதா஡ டகாஞ அநவுகளு஝஡் எரு தசப்பகட்டட எட஥ த஢ாருநாக பட஥த 

பழி பகுக்கி஦து. 

8 

ஆ஝ட்஝ாடகடி஧் எரு க஝஝்டந தசத஧்஢ா஝ட்ி஧் இருக்குண்ட஢ாது அதிலிரு஠்து 

஋ப்பாறு தபநிடத஦஧ாண்?  

ESC விடசடத ஋஠்ட ட஠஥ட்திலுண் அழுட்ட முடிம௅ண். எரு தசத஧் தசத஧்஢ா஝்டி஧் 

இருக்குண் த஢ாழுது ESC விடசடத அழுட்தி஡ா஧், அது அக்க஝்஝டநடத 

முடிவுக்குக் தகாஞ்டு பருண். 

 

9 

ஆ஥க்் ண஦்றுண் ச஥க்்கிந் த஢ாடட்ா஡்கந் ஋஠்ட ஥ி஢்஢஡் க஡்஝ட்஥ா஧் ட஢஡லி஧் 

உந்ந஡?  

Arc ண஦்றுண் Circle கருவிகந் அட஡ட்துண் ஥ி஢்஢஡ி஧் உந்ந Draw ட஢஡லி஧் எரு 

குழுபாக இருக்குண். 

 

10 

ERASE க஝஝்டநடத உந்நி஝஝்பி஡், ஆ஝ட்஝ாடக஝ ்உங்கடந ஋஡்஡ தசத்தச ்

தசா஧்கி஦து?  

எரு த஢ாருடந அழிக்க,  

Home tab → Modify pael → Erase tool ஋஡்஢டடக் கிநிக் தசத்து ERASE க஝்஝டநடதட் 

டட஥஠்்தடடுக்கவுண். (அ஧்஧து) க஝்஝டந ப஥ிம௃஧் ERASE அ஧்஧து E ஋஡ ட஝்஝சச்ு 

தசத்தவுண். இ஢்த஢ாழுது தசருகுண் புந்நி crosshair லிரு஠்து சிறித சது஥ணாக 

ணாறிம௃ருக்குண். இது pickbox ஋஡்று அடனக்க஢்஢டுண். இட஡் டடா஦்஦ண் திட஥ம௃஧் 

உந்ந எரு த஢ாருடநட் டட஥஠்்தடடுக்கட் டதா஥ாக உந்நது ஋஡்஢டடக் 

கா஝ட்ுகி஦து. டணலுண் க஝்஝டந ப஥ிம௅ண் த஢ாருடநட் டட஥஠்்தடடுக்கக் கூறுண். 

 

11 

இதுபட஥ டசமிக்காட டகா஢்ட஢ முட஧் முட஦தாக டசமிக்குண் த஢ாழுது, 

஢த஡்஢ா஝ட்ு஢் ஢஝ட்ி஢்஢஝ட்஝ம௃லிரு஠்து Save அ஧்஧து Save As… ஋஡்஢டடக் கிநிக் 

தசத்டா஧் ஋஡்஡ டடா஡்றுண்?  

ஆ஝்ட஝ாடகடி஧் ஠ீங்கந் தசத்ட டபட஧டத டசமிக்க,  

1. விட஥வு அணுக஧் கருவி஢்஢஝ட்஝ம௃஧் உந்ந Save த஢ாட்டாட஡க் கிநிக் 

தசத்த டபஞ்டுண்.  

2. பட஥஢஝ண் இதுபட஥ டசமிக்க஢்஢஝வி஧்ட஧ ஋஡ி஧், SaveDrawing As 

உட஥தா஝஧் த஢஝்டிடடா஡்றுண்.  

3. அதி஧் File name உட஥஢்த஢஝்டிம௃஧் பட஥஢஝ட்தி஦்கா஡ த஢தட஥க் 

தகாடுட்து Save த஢ாட்டாட஡க் கிநிக் தசத்தவுண். 

 

12 

ஆ஝ட்஝ாடகடி஧் எரு டகா஢்ட஢ தி஦஢்஢ட஦்கா஡ விட஥பா஡ பழி ஋஡்஡?  

சிப஢்பு ஠ி஦ட்தி஧் உந்ந ஢த஡்஢ா஝ட்ு஢் த஢ாட்டாட஡க் (A) கிநிக் தசத்டா஧், 

஢த஡்஢ா஝ட்ு஢் ஢஝்டி டடா஡்றுண். இ஠்ட ஢஝்டிதா஡து, புதித டகா஢்ட஢ 

உருபாக்குட஧், ஌஦்க஡டப உந்ந டகா஢்ட஢ட் தி஦ட்ட஧், ஠஝஢்புக் டகா஢்ட஢ 

டசமிட்ட஧், ஠஝஢்பு டகா஢்ட஢ ண஦்த஦ாரு த஢த஥ி஧், டபறு டகா஢்புட஦ம௃஧் 

டசமிட்ட஧், டபறு டகா஢்பு படிபட்தி஧் டசமிட்ட஧் ஠஝஢்புக் டகா஢்ட஢ அசச்ிடுட஧் 

ட஢ா஡்஦ டகா஢்பு தடா஝஥ப்ுட஝த க஝்஝டநகடநக் தகாஞ்டிருக்குண். 

 

13 

ஆ஝ட்஝ாடக஝ட்ிலிரு஠்து ஋ப்பாறு தபநிடத஦஧ாண்?  

உங்கந் டபட஧டத டசமிட்து ஆ஝்ட஝ாடக஝்டிலிரு஠்து தபநிடத஦,  

1. ஆ஝்ட஝ாடக஝் ச஡்஡஧் திட஥ம௃஧் டண஧் ப஧து மூட஧ம௃லுந்ந மூடு 

த஢ாட்டா஡க் (X) கிநிக் தசத்த டபஞ்டுண்.  

2. தி஦஠்திருக்குண் டகா஢்புகநி஧் ஌கடனுண் ணா஦்஦ண் தசத்த஢்஢஝்டிரு஠்டா஧், 

ஆ஝்ட஝ாடக஝் அடட டசமிக்க டபஞ்டுடணா அ஧்஧து டசமிக்காண஧் 

மூ஝டபஞ்டுடணா ஋஡்஢டட கீன்க்கஞ்஝ உட஥தா஝஧் த஢஝்டிம௃஧் 

உந்நடட஢் ட஢ா஡்று வி஡ா ஋ழு஢்புண். உங்கந் டபட஧டத டசமிக்க Yes 

த஢ாட்டாட஡க் கிநிக் தசத்த டபஞ்டுண்.  

3. ஌஦்க஡டப டசமிக்க஢்஢஝ாட புதித பட஥஢஝ணாக இரு஠்டா஧், ஆ஝்ட஝ாடக஝் 

Save Drawing As ஋஡்னுண் உட஥தா஝஧் த஢஝்டிடதட் திட஥ம௃஧் கா஝ட்ுண். 

பி஡்஡஥ ்டகா஢்ட஢ டசமிட்து ஆ஝்ட஝ாடக஝்டிலிரு஠்து தபநிததறுண். 
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஢குதி-இ 

III. எரு ஢டத்ிதநவி஧் விட஝தநிக்கவுண். 

1 

த஢ாருந்கடந உருபாக்குபட஦்கா஡ ஌டடனுண் மூ஡்று க஝஝்டநகடநக் கூறு.  

• ட஧஡் (Line) க஝்஝டநடதக் தகாஞ்டு டகாடுகந் பட஥த஧ாண்.  

• ச஥க்்கிந் க஝்஝டநடத஢் (Circle) ஢த஡்஢டுட்தி எரு ப஝்஝ண் பட஥த முடிம௅ண்.  

• RECTANG க஝்஝டந, ச஥ிதா஡ டகாஞ அநவுகளு஝஡் எரு தசப்பகட்டட 

எட஥ த஢ாருநாக பட஥த பழி பகுக்கி஦து.  

 

2 

விடச஢்஢஧டக மூ஧ண் LINE, CIRCLE ண஦்றுண் ERASE ட஢ா஡்஦ க஝்஝டநகடந ஋ப்பாறு 

விட஥பாக உந்நி஝஧ாண்?  

• க஝்஝டந ப஥ிம௃஧் LINE ஋஡ ட஝்஝சச்ு தசத்த டபஞ்டுண். பி஡்஡஥ ்ஆ஥ண்஢ x 

ண஦்றுண் y ஆதடத்டாட஧வுகடநக் தகாடுக்க டபஞ்டுண். பி஡்஡஥ ்முடிவு 

ஆதடத்டாட஧வுகடநக் தகாடுக்க டபஞ்டுண்.  

• க஝்஝டந ப஥ிம௃஧் CIRCLE ஋஡ ட஝்஝சச்ு தசத்து டணத஢்புந்நிகடந (x 

ண஦்றுண் y ஆதடத்டாட஧வுகடந) தகாடுக்க டபஞ்டுண். பி஡்஡஥ ் D 

(Diameter) ஋஡ ட஝்஝சச்ு தசத்து வி஝்஝ட்டட உந்நீ஝ டபஞ்டுண்.  

• க஝்஝டந ப஥ிம௃஧் ERASE அ஧்஧து E ஋஡ ட஝்஝சச்ு தசத்தவுண். 

அழிக்க டபஞ்டித த஢ாருநி஡் மீது pickbox-஍ டபட்து கிநிக் தசத்த 

டபஞ்டுண். த஢ாருளுட஝த டகா஝்டி஡் டடிண஡் தபநி஥ ் சாண்஢஧் 

஠ி஦ட்தி஦்கு ணாறுண். அழிக்க டபஞ்டித அட஡ட்து஢் த஢ாருந்கடநம௅ண் 

தடா஝஥஠்்து டடா஠்்தடடுக்க஧ாண் த௃ட஧வு விடசடத அழுட்ட டபஞ்டுண். 

 

3 

LINE க஝஝்டநம௃஧் உந்ந Undo டட஥வ்ி஡் ஢த஡்கடந ஋ழுதுக.  

எரு டகாடு பட஥ம௅ண் ட஢ாது முடிவு஢் புந்நிடதட் டப஦ாகக் குறி஢்பி஝ட்ுவி஝்஝ா஧், 

Undo க஝்஝டந மூ஧ண் கட஝சிதாகக் குறி஢்பி஝்஝ புந்நிடத ஠ீக்கிவி஝ட்ு, 

மு஠்டடத க஝்஝ட்தி஦்குச ் தச஧்஧஧ாண். இ஠்ட விரு஢்஢ட்டட஢் ஢த஡்஢டுட்ட, 

க஝்஝டந ப஥ிம௃஧் Undo அ஧்஧து U ஋஡ட ் ட஝்஝சச்ு தசத்து த௃டனவு விடசடத 

அழுட்ட டபஞ்டுண்.  

 

4 

ப஝஝்ங்கடந உருபாக்குண் பி஡்பருண் முட஦கடந சுருக்ணாக விப஥ி.  

அ. Centre and radius  

• க஝்஝டந ப஥ிம௃஧் CIRCLE ஋஡ ட஝்஝சச்ு தசத்து த௃டனவு த஢ாட்டாட஡ 

அழுட்டவுண். பி஡்஡஥ ் க஝்஝டந ப஥ிம௃஧் டணத஢்புந்நிடத (x ண஦்றுண் y) 

குறி஢்பி஝ட்ு த௃டனவு த஢ாட்டாட஡ ஆழுட்ட டபஞ்டுண். பி஡்஡஥ ்

ஆ஥ட்திட஡ உந்நீ஝ட்ு த௃டனவு த஢ாட்டாட஡ அழுட்ட டபஞ்டுண்.  

ஆ. Centre and diameter  

• க஝்஝டந ப஥ிம௃஧் CIRCLE ஋஡ ட஝்஝சச்ு தசத்து த௃டனவு 

த஢ாட்டாட஡ அழுட்டவுண். பி஡்஡஥ ்க஝்஝டந ப஥ிம௃஧் டணத஢்புந்நிடத 

(x ண஦்றுண் y) குறி஢்பி஝ட்ு த௃டனவு த஢ாட்டாட஡ ஆழுட்ட டபஞ்டுண். 

பி஡்஡஥ ்க஝்஝டந ப஥ிம௃஧் D ஋஡ ட஝்஝சச்ு தசத்து த௃டனவு த஢ாட்டாட஡ 

அழுட்ட டபஞ்டுண். இ஢்ட஢ாது வி஝்஝ ணதி஢்பிட஡ ட஝்஝சச்ு தசத்து 

த௃டனவு஢் த஢ாட்டாட஡ அழுட்ட டபஞ்டுண். 

 

 

஢குதி – ஈ 

IV. எரு ஢க்க அநவி஧் விட஝தநிக்கவுண் 

1 

ஆ஝ட்஝ாடக஝ ்இட஝முகட்டட஢் ஢஦்றி விப஥ி.  

ஆ஝்ட஝ாடக஝் 2016 இ஡் இட஝முகணா஡து ஥ி஢்஢஡்கடநம௅ண், ஢த஡்஢ா஝ட்ு஢் 

஢஝்டிகடநம௅ண் அடி஢்஢ட஝தாகக் தகாஞ்஝து. இ஠்ட இட஝முகட்தி஡் 

முக்கிதணா஡ அண்சண் பட஥கட஧஢் ஢குதிம௃஡் அநவு த஢஥ிதடாக இருக்குண்.  

஢த஡்த஢ா஝ட்ு஢் ஢஝ட்ி (ApplicationMenu)  

சிப஢்பு ஠ி஦ட்தி஧் உந்ந ஢த஡்஢ா஝ட்ு஢் த஢ாட்டாட஡க் (A) கிநிக் தசத்டா஧், 

஢த஡்஢ா஝ட்ு஢் ஢஝்டி டடா஡்றுண். இ஠்ட ஢஝்டிதா஡து, புதித டகா஢்ட஢ 

உருபாக்குட஧், ஌஦்க஡டப உந்ந டகா஢்ட஢ட் தி஦ட்ட஧், ஠஝஢்புக் டகா஢்ட஢ 

டசமிட்ட஧், ஠஝஢்பு டகா஢்ட஢ டபத஦ாரு த஢த஥ி஧், டபறு டகா஢்புட஦ம௃஧் 

டசமிட்ட஧், டபறு டகா஢்பு படிபட்தி஧் டசமிட்ட஧், ஠஝஢்புக் டகா஢்ட஢ 

அசச்ிடுட஧் ட஢ா஡்஦ டகா஢்பு தடா஝஥ப்ுட஝த க஝்஝டநகடநக் 

தகாஞ்டிருக்குண். ஢த஡்஢ா஝ட்ு஢் ஢஝்டிம௃஡் டண஧் ஢குதிம௃஧் டட஝஧் ஢஝ட்஝ 

(Search bar)  இ஝ண் த஢஦்றிருக்குண்.  

டட஧஢்பு஢் ஢஝ட்஝ (Title bar)  

டட஧஢்பு஢் ஢஝ட்஝தா஡து Autodesk AutoCAD 2016 ஋஡்னுண் தண஡்த஢ாருநி஡் 

 

www.Padasalai.Net                                                                   www.CBSEtips.in

Kindly send me your answer keys to our email id - padasalai.net@gmail.com



Padasalai.Net

 31 ,uh.ghh;j;jPgd;>M.Sc.,M.Ed.,M.Phil., fzpdp gapw;Weh;> muR Mz;fs; Nky;epiyg;gs;sp - ghg;gpnul;bg;gl;b 

 

த஢தட஥ம௅ண், ட஦்ட஢ாடடத பட஥஢஝ட்தி஡் த஢தட஥ம௅ண் தகாஞ்டிருக்குண்.  

விட஥வு அணுக஧் கருவி஢்஢஝ட்஝ (Quick Access Toolbar)  

இ஠்ட கருவி஢்஢஝ட்஝, ச஡்஡஧் திட஥ம௃஡் இ஝து டண஧் ஏ஥ட்தி஧் சிப஢்பு ஠ி஦ 

த஢ாட்டாட஡ அடுட்துக் காஞ஢்஢டுண். இ஠்ட஢் ஢஝ட்஝ Workspace ண஦்றுண் 

Undo/Redo க஝஝்டநகளுக்குண், ஢த஡்஢ா஝ட்ு஢் ஢஝ட்஝ம௃஧் உந்ந அட஡ட்து 

டகா஢்புக் க஝்஝டநகளுக்குண் ஢ஞிக்குறிகடநக் தகாஞ்டிருக்குண்  

஥ி஢்஢஡் (Ribbon)  

ஆ஝்ட஝ாடக஝் 2016 ச஡்஡஧் திட஥ம௃஡் டண஧் ஢குதிம௃லுந்ந டட஧஢்பு஢் 

஢஝ட்஝க்கு கீன் உந்ந ஢குதி ஥ி஢்஢஡் ஆகுண். இ஠்ட ஥ி஢்஢஡் இ஥ஞ்டு 

஢குதிகடந உட஝தது. Ribbon Tab, Ribbon Panel  

Start தடாகுதி  

Start தடாகுதிடதக் கிநிக் தசத்டவு஝஡், ஆ஝்ட஝ாடக஝் 2016 இ஡் தடா஝க்கட் 

திட஥ ணறு஢டிம௅ண் டடா஡்றுண். அட஡் மூ஧ண் புதித பட஥஢஝ட்டடட் 

தடா஝ங்குட஧், ஌஦்க஡டப உந்ந பட஥஢஝ட்டட தி஦ட்ட஧் ட஢ா஡்஦ 

தசத஧்கடநச ்தசத்தவுண்.  

File தடாகுதி  

஥ி஢்஢னுக்கு கீடன File தடாகுதி ஢஝ட்஝ உந்நது. தி஦க்க஢்஢டுண் எப்தபாரு 

டகா஢்பி஦்குண் எரு தடாகுதி உருபாக்க஢்஢டுண். File தடாகுதிம௃஡் மூ஧ண் எரு 

பட஥஢஝க் டகா஢்பிலிரு஠்து ண஦்த஦ாரு பட஥஢஝க் டகா஢்பி஦்கு ஋நிடாக 

டாவிச ்தச஧்஧ முடிம௅ண்.  

பட஥஢஝஢் ஢குதி  

திட஥ம௃஡் த஢ருணநவு஢் ஢குதி பட஥஢஝஢் ஢குதி (Drawing Area) ஆகுண். இதி஧் 

த஢ாருந்கடநம௅ண், மு஢்஢஥ிணாஞ பட஥கட஧கடநம௅ண் ஋நிடாக பட஥த 

முடிம௅ண்.  

க஝஝்டந சாந஥ண் (Command Window)  

஢த஡்஢ா஝ட்ு சாந஥ட்தி஡் அடி஢்஢குதிம௃஧்,  ஠ிட஧டண஢் ஢஝ட்஝க்கு (Status bar) 

டண஧ாக க஝்஝டந சாந஥ண் அந஠்திருக்குண். இ஠்டச ் சாந஥ட்தி஧் த஢ாதுபாக 

மூ஡்று உட஥ப஥ிகந் காஞ஢்஢டுண். முட஧் இ஥ஞ்டு ப஥ிகந், இட஦்கு மு஡் 

஢த஡்஢டுட்தித க஝்஝டநகடநக் கா஝ட்ுண். கட஝சி ப஥ிதா஡து க஝்஝டந ப஥ி 

ஆகுண். க஝்஝டநச ்சாந஥ண் டடா஡்஦ா வி஝்஝ா஧் Ctrl + 9 ஋஡்னுண் விடசகடந 

அழுட்தி டடா஡்஦ச ்தசத்த஧ாண்.  

சமீ஢டத்ித உந்நடீு (Recent input)  

‘Command’: prompt இ஧் ஠ாண் கட஝சிதாக ட஝்஝சச்ு தசத்ட 20 க஝்஝டநகடந, 

ஆ஝்ட஝ாதக஝் ஠ிட஡வி஧் தகாஞ்டிருக்குண். இ஠்ட க஝்஝டநகளுக்கு ‚Recent 

Input‛ ஋஡்று த஢த஥.்  

UCS ஢ஞிக்குறி  

பட஥஢஝஢் ஢குதிம௃஡் கீன் இ஝து மூட஧ம௃஧் உந்ந L  படிப டகா஝்டி஦்கு UCS 

஢ஞிக்குறி ஋஡்று த஢த஥.் UCS ஋஡்஢து ‚User Coordinate System‛ ஋஡்஢ட஡் 

குறுக்கணாகுண்.  

உ஧வுட஧் ஢஝ட்஝ (Navigation Bar)  

உ஧வுட஧் ஢஝ட்஝தா஡து பட஥஢஝஢்஢குதிம௃஧் இருக்குண். இது 

உ஧வுடலுக்கா஡ கருவிகடநக் தகாஞ்டிருக்குண்.  

஠ிட஧டண஢் ஢஝ட்஝ (Status Bar)  

க஝்஝டந ப஥ிக்கு கீடன ஠ிட஧டண஢்஢஝ட்஝ இருக்குண். சா஥டத்ி஡் கீன் ப஧து 

மூட஧ம௃஧் உந்ந ஢஝ட்஝ ஢த஡்஢ா஝ட்ு ஠ிட஧டண஢் ஢஝ட்஝ (Application Status 

Bar) ஆகுண்.  

பட஥஢஝ ஆதட ்தடாட஧வுகந் (Drawing Coordinates)  

ஆ஝்ட஝ாடக஝் 2016 இ஧் டி஥ாம௃ங் டகாஆ஥ட்ிட஡஝் த஢ாட்டா஡் டா஡டணபாக 

ணட஦க்க஢்஢஝்டிருக்குண். கஸ்஝டணடஷச஡் ஢஝்டிடத஢் (Customization menu) 

஢த஡்஢டுட்தி அடடக் காஞ்பிக்க முடிம௅ண்.  

ணா஝஧் (MODEL)  

பட஥஢஝ண் பட஥பட஦்காக ணா஝஧் ஢குதிம௃஧் ஢ஞிபு஥ிம௅ண் த஢ாழுது, ணா஝஧் 

(MODEL) த஢ாட்டா஡் டா஡டணபாகட் டட஥஠்்தடடுக்க஢்஢஝்டிருக்குண்.  

஢ஞிடட்நண் (Workspace)  

஢ஞிட்டநண் ஋஡்஢து பட஥஢஝஢் ஢குதிம௃஡் இ஝ண் ண஦்றுண் டடா஦்஦ண், 

அட஡ட்துவிட ஢஝்டிகந், த஢ாட்டா஡்கந், த஢ாட்டா஡் தடாகுதிகந் அ஝ங்கித 

எரு முழுடணதா஡ ஢த஡஥ ்இட஝முகண் ஆகுண். 
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க஝஝்டநச ்சாந஥ண் ஢஦்றி விப஥ி.  

க஝஝்டந சாந஥ண் (Command Window)  

஢த஡்஢ா஝ட்ு சாந஥ட்தி஡் அடி஢்஢குதிம௃஧், ஠ிட஧டண஢்஢஝ட்஝க்கு (Status bar) 

டண஧ாக க஝்஝டந சாந஥ண் அடண஠்திருக்குண். இ஠்டச ்சாந஥ட்தி஧் த஢ாதுபாக 

மூ஡்று உட஥ப஥ிகந் காஞ஢்஢டுண். முட஧் இ஥ஞ்டு ப஥ிகந், இட஦்கு மு஡் 

஢த஡்஢டுட்தித க஝்஝டநகடநக் கா஝ட்ுண். கட஝சி ப஥ிதா஡து க஝்஝டந ப஥ி 

ஆகுண். க஝்஝டநச ்சாந஥ண் டடா஡்஦ாவி஝்஝ா஧் Ctrl + 9 ஋஡்னுண் விடசகடந 

அழுட்தி டடா஡்஦ச ் தசத்த஧ாண். க஝்஝டந ப஥ிம௃஧் தசருகுண் புந்நி உந்ந 

இ஝ட்தி஧் க஝்஝டநகடந உந்நி஝ முடிம௅ண். இது Command: prompt ஋஡ 

அடனக்க஢்஢டுண். க஝்஝டநம௃஡் முட஧் ஋ழுட்டட ட஝்஝சச்ு தசத்டவு஝஡், 

அ஠்ட ஋ழுட்தி஧் தடா஝ங்குண் அட஡ட்துக் க஝்஝டநகநி஡் ஢஝்டித஧் 

டடா஡்றுண்.  

குறி஢்பு  

க஝்஝டந ப஥ிம௃஧் ணதி஢்புகடந உந்நி஝்஝வு஝஡் த௃டனவு விடசடத அழுட்ட 

டபஞ்டுண். இ஠்டச ் சாந஥ட்டட கிநிக் தசத்து இழுட்து திட஥ம௃஧் ஋ங்கு 

டபஞ்டுணா஡ாலுண் டபக்க஧ாண். அநடபம௅ண் ணா஦்஦஧ாண். க஝்஝டநடத 

உந்நிடுண் ட஢ாது சிறித ஋ழுட்திட஧ா, த஢஥ித ஋ழுட்திட஧ா அ஧்஧து இ஥ஞ்டுண் 

க஧஠்டடா தகாடுக்க முடிம௅ண். க஝்஝டந ப஥ிம௃஧் ட஝்஝சச்ு தசத்ம௅ண் த஢ாழுது 

பிடன ஌஦்஢஝்஝ா஧், BACKSPACE விடச மூ஧ண் அழிட்துவி஝ட்ு ச஥ி தசத்த஧ாண். 

ESC விடசடத ஋஠்ட ட஠஥ட்திலுண் அழுட்ட முடிம௅ண். எரு தசத஧் 

தசத஧்஢ா஝்டி஧் இருக்குண் த஢ாழுது ESC விடசடத அழுட்தி஡ா஧், அது 

அக்க஝்஝டநடத முடிவுக்குக் தகாஞ்டு பருண்.  

ஆ஝்ட஝ாடகடி஧் மு஡்஡டாக஢் ஢த஡்஢டுட்தித க஝்஝டநடதட் திருண்஢வுண் 

஢த஡்஢டுட்ட டபஞ்டுதண஡ி஧், Command: prompt இ஧் த௃டனவு விடச (ENTER) 

அ஧்஧து இட஝தபநி விடசடத (spacebar) அழுட்ட டபஞ்டுண். ணா஦ாக 

சு஝்டிடத ப஧து கிநிக் தசத்பட஡் மூ஧ண் டடா஡்றுண் ஢஝்டிம௃஧், Repeat 

஋஡்னுண் விரு஢்஢ட்டட டட஥஠்்தடடுக்க஧ாண்.  

சமீ஢டத்ித உந்நடீு (Recent input)  

‘Command’: prompt இ஧் ஠ாண் கட஝சிதாக ட஝்஝சச்ு தசத்ட 20 க஝்஝டநகடந, 

ஆ஝்ட஝ாடக஝் ஠ிட஡வி஧் தகாஞ்டிருக்குண். இ஠்ட க஝்஝டநகளுக்கு ‚Recent 

Input‛ ஋஡்று த஢த஥.் க஝்஝டநகநி஡் ஢஝்டிதட஧க் காஞ விருண்பி஡ா஧் 

சு஝்டிடத ப஧து கிநிக் தசத்து பருண் ஢஝்டிம௃஧் Recent input ஋஡்஢டடக் கிநிக் 

தசத்த டபஞ்டுண். ஆ஝்ட஝ாடக஝் இட஦்கு மு஡் ஢த஡்஢டுட்தித 

க஝்஝டநகடநம௅ண், ஆதடத்டாட஧வு உந்நடீுகடநம௅ண் (Coordinate Inputs) 

துடஞ஢்஢஝்டிதலி஧் கா஝ட்ுண்.  
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த஥க்஝ாங்க஧் த஢ாருடந஢் ஢஦்றி ஋ழுதுக. ஆ஝ட்஝ாடகடி஧் தசப்பகண் 

பட஥பட஦்கா஡ பழிமுட஦கடநக் கூறு.  

தசப்பகண் பட஥ட஧்  

படிபடண஢்஢ாந஥க்ந் ஢த஡்஢டுட்துண் அடி஢்஢ட஝ படிபங்கநி஧் எ஡்று 

தசப்பகண் ஆகுண். ட஧஡் க஝்஝டநடத஢் ஢த஡்஢டுட்திம௅ண் தசப்பகண் பட஥த 

முடிம௅ண். ஆ஡ா஧் அதி஧் சி஧ குட஦஢ாடுகந் உந்ந஡.  ஋டுட்துக்கா஝்஝ாக, டகாஞ 

அநவுகந் 90 டிகி஥ி உந்ந஡பா ஋஡ ச஥ி஢ா஥க்்க டபஞ்டுண். டணலுண் எப்தபாரு 

டகாடுண் ட஡ிட்ட஡ி த஢ாருநாக இருக்குண். எரு டகா஝்டி஡் மீது கிநிக் தசத்டா஧் 

அ஠்ட டகாடு ண஝ட்ுடண டட஥வ்ு தசத்த஢்஢டுண். ண஦்஦ டகாடுகந் டட஥வ்ு 

தசத்த஢்஢஝ாது. ஆடகதா஧் ஆ஝்ட஝ாடக஝் 2016 இ஧் உந்ந RECTANG க஝்஝டந, 

ச஥ிதா஡ டகாஞ அநவுகளு஝஡் எரு தசப்பகட்டட எட஥ த஢ாருநாக பட஥த 

பழி பகுக்கி஦து. இ஠்ட RECTANG க஝்஝டநடத஢் ஢த஡்஢டுட்தி பட஥த஢்஢஝்஝ 

தசப்பகட்தி஡் ஋஠்டதபாரு இ஝ட்திலுண் கிநிக் தசத்து முழு தசப்பகட்டடம௅ண் 

டட஥஠்்தடடுக்க முடிம௅ண்.  
 

சு஝ட்ுக்குறிம௃஡் மூ஧ண் தசப்பகடத்ி஡் முட஡கடநட ்டட஥஠்்தடடுடத்ு தசப்பகண் 

பட஥ட஧்  

1. Command: RECTANG (அ஧்஧து) REC (த௃டனவு விடசடத அழுட்டவுண்).  

2. க஝்஝டந ப஥ிம௃஧் கீன்க்கஞ்஝பாறு டடா஡்றுண்.  

RECTANGLE  Specify first corner point or [Chamfer/ Elevation/Fillet/Thickness/Width]:  

தசப்பகட்தி஡் முட஧் முட஡ (P1) பட஥த டபஞ்டித இ஝ட்தி஦்கு 

சு஝ட்ுக்குறிடத ஠க஥ட்்தி சு஝்டிம௃஡் இ஝து த஢ாட்டாட஡க் கிநிக் 

தசத்தவுண்.  
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3. க஝்஝டந ப஥ிம௃஧் கீன்க்கஞ்஝பாறு டடா஡்றுண்.  

Specify other corner point or [Area / Dimensions / Rotatio]:  

தசப்பகட்தி஡் முட஧் முட஡ம௃லிரு஠்து சு஝்டிடத மூட஧வி஝்஝ண் 

பழிதாக ஠க஥ட்்தி, ணறுமுட஡ம௃஧் (P2) சு஝்டிம௃஡் இ஝து த஢ாட்டாட஡க் 

கிநிக் தசத்தவுண். இ஢்த஢ாழுது தசப்பகண் பட஥த஢்஢஝்டிருக்குண். 
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